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This preface contains the following:
•

an overview of this manual

•

a list of the documentation conventions used in this manual

•

an overview of the BBN/Slate ™ documentation

About this manual
BBN/Slate Getting Started introduces you to BBN/Slate multimedia
document communication software. This tutorial provides you with
practice exercises for learning the basics and offers suggestions for
using BBN/Slate's more advanced features.
If you are new to BBN/Slate, Getting Started will get you up and
running. You do not need to have any previous experience with
the software to use this book.
If you have used BBN/Slate before, this book can give you new
ideas for using the software in your everyday work. You can also
use this book to remind yourself how to do basics tasks.
What you should
already know

Before starting this tutorial, you should be familiar with your
workstation. You should know how to get in and out of your
windowing system and how to use a mouse.
If you are not comfortable using your workstation or do not know
how to get into your windowing system, read your workstation
documentation before continuing.
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How this book is
organized

This tutorial has eight chapters, each of which teaches you
something new about BBN/Slate.
•

Chapter 1 introduces you to BBN/Slate and tells you everything
you need to know to use this book.

•

Chapter 2 helps you start up BBN/Slate, shows you how to
create folders and files, and walks you through a sample
document.

•

In Chapter 3, you create a file and learn to use BBN/Slate's
text editor.

•

Chapter 4 shows you the different ways to use BBN/Slate's
electronic mail system. In this chapter, you learn to mail
existing documents and compose new messages.

•

In Chapter 5, you change information in a spreadsheet and then
create a new one. You also learn to analyze data and to make
a piechart.

•

Chapter 6 shows you how to add images from the file system
and create your own graphics.

•

In Chapter 7, you learn how to put your BBN/Slate documents
into printed form.
Chapter 8 gives you a glimpse of the other activities available
in BBN/Slate.

Documentation conventions

TOi'

this manuOl[

Unless otherwise noted in the text, this book uses the conventions
described in this section.
Mouse
operations

To tell you which mouse button to use and how to use it, this
book gives the button first, followed by the action.
•

The button can be the left, middle, or right button .

•

The action can be click, hold, drag, or release .
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For example:
left click
means you click with the left mouse button.

Boldface font

This boldface font, when preceded by a diamond, designates
actions you should take as part of the tutorial exercise. For
example, the following text:
() Left click on the compose button.
means that you click on the compose button using the left mouse
button.

Text you type

Text that you enter in the editor appears in this font and is
indented from the margin. For example, you would enter the
following text in the editor:
Project Saturn is a software package that runs
on most workstations.

<RET> and
<TAB>

The Return and Tab keyboard keys are designated by <RET> and
<TAB> whenever they follow text that you type in. For example,
in the following text:
100

*

45 <RET>

you type the characters before the <RET>, and then press the
Return key.
Menu options

Menu options are given with the form:
menuname-option
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For example, the following menu option:
Text-Fonts-Face-Italics

shows that Text is the top-level menu, Fonts is a submenu of
Text, Face is a submenu of Fonts, and Italics is an option
of the Face menu.
Italic font

This italic font identifies new terms and book names.

Monospace font

This rnonospace font indicates names of folders, documents,
buttons, and menus. For example, the following names all appear
In monospace:
+Welcorne folder
Introduction document
show button
Print menu

Overview of BBN/Slate documentation
User
documentation

The BBN/Slate documentation set includes the following manuals:

Getting Started introduces you to BBN/Slate through a series of
tutorial exercises.
The Reference Manual gives a complete description of the
BBN/Slate system.

•

The Customizing Manual explains how you can tailor the
BBN/Slate system to fit your needs. Topics include
reconfiguring the menu system, and writing your own programs
using the Slate Extension Language (SEL).
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On-line help

•

System Topics is a collection of documents covering system
topics such as the structure of BBN/Slate document files,
command-line document management tools, and mail utility
programs.

•

Multilingual Documents describes how to create documents in
five other writing systems (Arabic, Cyrillic, Hangul, Hebrew,
and Thai) available with the BBN/Slate Multilingual Option.
Note: If you did not order the Multilingual Option, you will
not receive this manual.

In addition to the printed documentation, BBN/Slate has an on-line
menu help facility that provides information on all command and
menu choices. Also, BBN/Slate provides on-line UNIX manual
pages with information about BBN/Slate's command-line programs
and utili ties.

Installation and
release notes

System-specific installation instructions and release notes
supplement the BBN/Slate user documentation set.
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This section explains how you can:
order documentation
obtain technical assistance
obtain training services

How to order documentation
To order additional copies of this manual or any other BBN/Slate
manual:

In North America, mail a completed purchase order to:
BBN Software Products
A Division of Bolt Beranek and Newman Inc.
10 Fawcett Street
Cambridge, MA 02138
AnN: Sales Administration

For prices and other ordering information, call Sales Administration
at 617/873-5115.
Outside North America, contact the nearest Sales and Support
office.
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How to obtain technical assistance
For BBN/Slate customers who are on maintenance and need
technical assistance:
In North America, call the Hotline number: 617/873-3968.
Hotline hours are Monday through Friday, 8:30 a.m. to 8 p.m.
(EST).

•

Outside North America, contact the nearest Sales and Support
office.

How to obtain training
BBN supports its customers and products with a full range of
training programs. BBN/Slate courses are offered in conjunction
with hardware vendors or at BBN education centers. In addition,
arrangements can be made with the Education Services department
to present the same courses at customer sites.
To receive a course catalog or additional information:
In North America, call the Course Registrar at 617/873-8383.
Outside North America, contact the nearest Sales and Support
office.
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1
Welcome to BBN/Slate multimedia document communication
software - a system designed to help you develop ideas and share
information. BBN/Slate gives you a complete set of integrated
tools normally found only in multiple software packages. Through
BBN/Slate's document editor, you can use these tools to develop
multimedia documents and share them with people across the office
or around the world.
This chapter introduces you to the main features of BBN/Slate,
shows you how to use BBN/Slate in your everyday work, gives
you an overview of the BBN/Slate interface, and tells you how to
use this self-paced tutorial.

USing BBN/Slate for your everyday

WOi~{

Creative
communication

Think of BBN/Slate as a creative communication tool. Use it to
create your everyday documents as well as special materials for
presentations and meetings. However, don't limit yourself to using
BBN/Slate just as a document-creation tool. You can also make
use of BBN/Slate's communication abilities.

Creating
documents

With BBN/Slate, you can create everything from on-line
newsletters to graphical presentation materials to reports. Any
document can contain any number of media types, from text to
graphics to speech.
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Communica ting
information

You can communicate information using BBN/Slate's electronic
mail facility, which lets you mail any multimedia document. You
can also confer with other users or attach voice annotations your own digitized speech - within any document. If you need
to share data with other users, use the BBN/Slate enclosure feature.

Getting acquainted with BBN/Slate's feattH',9S
At the center of BBN/Slate is an integrated document editor, where
you create and modify multimedia documents. These documents
are made up of media types, such as text and graphics. BBN/Slate
gives you lots of features for working with documents in the
document editor.
Media types

BBN/Slate includes a full array of media types, including text,
spreadsheets and business graphs, images, graphics, digitized
speech, and enclosures. Each media type has its own editor that
you use to create and modify elements of that media type.
Text. Most of your multimedia documents wiII probably contain
text, although you don't have to include text. The text editor lets
you choose from several type styles and sizes. If you have the
Multilingual Option, you can create text in languages other than
English.
Spreadsheets and business graphs. For presenting and analyzing
financial or other numerical information, you can create
spreadsheets. The spreadsheet editor lets you create line charts,
bargraphs, and piecharts, which you can easily generate from your
spreadsheets and regenerate whenever you change values or
formulas in the spreadsheet itself.
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Graphics. In the graphics editor, you can create line drawings
complete with geometric shapes, fill patterns, built-in arrow styles,
and text.
Images. You can create or import your own images, which may
be scanned photographs, drawings, or screen captures from your
workstation display.
Digitized speech. With the proper hardware, you can insert and
play back digitized speech annotations. Using the speech media
type, you can make comments on documents you are reviewing or
just add a personal touch to a document.
Enclosures. Enclosures let you send files such as UNIX®
programs or data files to other BBN/Slate users. Depending on the
file you send, the recipient can edit, execute, and print the
enclosure.
Electronic mail

Anything you can create in BBN/Slate, you can send through
electronic mail. Mail makes it easy for you to gather information
from other people and share your own ideas with others. Now
you can send documents containing the above media types through
the mail.
Because mailing a multimedia document doesn't affect the media
types, recipients can work with the mailed copy as if it were an
original. For example, if you send a spreadsheet to someone to
review, that person could change some values and send the
spreadsheet back to you.

Electronic
conferencing

To help you collaborate more easily with others, BBN/Slate
includes a conferencing feature. Several people can confer over a
document, although only one person at a time has control over the
document. With the conferencing feature, you can reconcile
different opinions about a document or hold brainstorming sessions.
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Similar to the conferencing feature, the conversation window lets
you type in a dialog with other users without carrying on the
phone conversation that you would have in a standard conference.
Extension
Language

BBN/Slate's built-in programming language lets you customize and
expand the system for yourself or for your work group. With the
Slate Extension Language (SEL), you can automate many of the
tasks you do every day.

Using the BBN/Slate interface
BBN/Slate works with your workstation's windowing system. As
with other workstation software, you select menu options and
operate buttons by using a mouse, and if you like, keyboard
shortcuts.
This tutorial helps you become comfortable with the BBN/Slate
user interface by guiding you through the creation of a multimedia
document. Mter you finish with the tutorial, refer to the
BBN/Slate Reference Manual if you have any questions about the
user interface.

Using this book
This tutorial helps you learn BBN/Slate by walking you through
creating, sharing, and printing multimedia documents. To benefit
the most from BBN/Slate Getting Started, work through each
chapter in order, as the exercises build on each other.
In this tutorial, you learn how to work with most of the BBN/Slate
media types, including text, graphics, images, and spreadsheets and
business graphs. Each chapter teaches you how to work with a
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particular media type or feature. For instance, in Chapter 3, you
learn how to use the text editor by creating a document, and in
Chapter 4, you learn about electronic mail by sending, forwarding,
and reading messages.
The Epilogue (Chapter 8) gives you a glimpse of the other
activities available in BBN/Slate. Turn to the Epilogue to learn
about more advanced features of each of the media types and
about media types that this tutorial doesn't cover. For more
information about any of the activities in the Epilogue, see the
Reference Manual.
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2
In this book, you assume the role of a product manager at a
high-tech company. You are currently managing the most recent
addition to your company's product line - a software package
code-named "Project Saturn."
Your boss has asked you to present information about Project
Saturn at a company meeting in only a few days. Fortunately,
your company has just obtained BBN/Slate, and you and your boss
are confident that it will help you meet the tight deadlines facing
you.
While working through this book, you create presentation materials
that you will hand out at the company meeting. By creating these
materials, you learn about using BBN/Slate to make multimedia
documents and share information with others.
Excited about using BBN/Slate, you sit down at your workstation.
During this session, you:
start BBN/Slate
•

open folders and documents
move through a document

•

learn how to manage folders and files
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Starting BBN/Slate
Before you
begin

To work through this tutorial, you must have BBN/Slate already
installed on your system, and you should be in your windowing
system. If BBN/Slate is not already installed on your system, see
the BBN/Slate Installation Instructions to install the software
yourself, or have someone else do it for you before you continue.

Getting into
BBN/Slate

Start BBN/Slate from within your windowing system.

~

Enter your windowing system if you haven't already.

~

Enter the following command from within a window:
% slate <RET>
If you do not have BBN/Slate installed on your system, you see
this error message:

slate:

Command not found

If you see this error message, you must first install BBN/Slate
before you can continue.
If you do have BBN/Slate installed, you see the following start-up
screen:
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I

1:

4 Apr 90

BBN

,

Welcome to BBN/SJa.te ReJease 1,1

Document
manager

~

+Gettmg Started
+Mailbox
+demo

(forward)

~
~
~
~~~~

Folder: •

BBN/

Document
editor

Release 1.1
Used under license from
BBN Softwaro Products Corporation
Copyright (c) 1990 by
BBN Systems and Technologies Corporation
All rights reserved.
one initializin

multilin ual text.

BBN/Slate start-up screen

BBN/Slate divides the start-up screen into two windows, a
document manager window, and a document editor window.
The document manager, divided into two sections, or panes, lists
all of your BBN/Slate folders and files. Below the document
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manager is the document editor, where you work with BBN/Slate
documents. Depending on how your system has been set up, the
document editor may appear beside the document manager rather
than below it.
The top pane of the document manager, or document summary
pane, contains information about all of the BBN/Slate files in the
current folder. Non-BBN/Slate files in the folder (such as
bitmapped images) do not appear in the listing.
The bottom pane, or command pane, contains command buttons
that help you work with folders and files. You'll learn how to use
these buttons later.
Document
names ~
!:":I: :

~rJ.~F.t;

1:

E'f8;rnr. .
4 Apr 90

,. Ilrili:!il

BBN

.. . ,

"

'

..

'

..... Welcome to BBN/Slate Aelease 1.1

)
I

Document
summary
pane

~

(compose)~( cancel)

~

(forward)

(new mail)

+Ma.lbox
~."'"'

~
~
~
~

~

+d7

~~(delete)

Folder names

FOlde~

'"' ' I
~

~ ~

Command

)~ ane

1/

/

Document manager

Using the mouse

Before moving into the tutorial exercises, take a few minutes to
get familiar with using the mouse in BBN/Slate.
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The mouse has three buttons, each of which has a special function
in BBN/Slate:
•

Use the left button to select folders, files, and media types
within documents.

•

Use the middle button to display help messages and to perform
other specialized tasks.

•

Use the right button to select and execute options from menus.

Select folders, files,
and media types
Display help and do
other specialized tasks
Select and execute options

Using the mouse

You use the mouse buttons by clicking, holding, and dragging. To
click, press the button and release. Sometimes, you may need to
double-click, or press the button twice quickly.
To hold, press and hold the button down. To drag, press the
button down, move the mouse (according to the task you are
doing), and release.
The instructions in this tutorial tell you the button to use and
whether to click, hold, or drag. For example, if the instructions
tell you to "Left click on the document name," then position the
pointer over the document name and click once using the left
mouse button.
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Opening folders and documents
BBN/Slate comes with a sample document designed to acquaint
you with the software. This document, called Introduction,
appears in a folder called +Getting Started. Your boss has
recommended that you look at this document before creating your
own BBN/Slate files.
Opening a
folder

In the document manager, you should see the folder name
+Getting Started, which contains the sample documents you
use while working through this tutorial. You also see a folder
called +Mailbox, which is where you receive mail, and a folder
called +demo, which contains more sample documents. All folders
in BBN/Slate begin with the plus sign (+).
If you are a new user and are working in your own account, you
should see only three folders in the folder list. If you don't see
the name +Getting Started in the folder list, left click on
either set of arrows beside the list until you see the name .
'~: :lni>lF.:\~ii1r. ·l~<~>:;: ,\.'-~l'JF.:\1:

1:

( show )

4 Apr 90

(compose) (

":i>Ji>x.

BBN

send

.·.• ·"tIN.!ir;j~·

) ( cancel)

( done )

(forward)

(new mail)

( print )

( filter )

( sort )
( select )

Folder: •

( conf )

·!i!.r, •.

......
:,.,

+Mailbox
.om'",
+demo

( next ) ( reply ) ( delete)

folder

' '7I
...

I'

Moving through the folder list

//

J~

...

~

~

Left click on
either set of arrows
to scroll through
the folder list
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To open a folder, you highlight its name
click on the folder button.
¢

In

the folder list and

Using the left mouse button, click on the name +Getting
started.

V Left click on the folder button.
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Document manager

The contents of the +Getting Started folder appear in the
document summary pane.
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Introduction
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( show)
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( done

(forward)

(new mail)

(

print)
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(

sort)

( select)
(

conf

)

Folder: +Getting StarteJi
(

next

) ( reply ) ( delete )

( folder)
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Contents of the Getting Started folder

Your manager has told you that the document acquainting you with
BBN/Slate is called Introduction. You want to see what the
document contains, so you open it and see it in the document
editor window.

Opening a
document

To open a document, highlight its name and click on the show
button.
~

Using the left mouse button, click on the document name

Introduction.
Once you've become more experienced with BBN/Slate, you will
have created many files, and all of your files in a given folder
may not be visible at once. If this happens, scroll through the list
by left clicking on the arrows in the scroll bar beside the document
summary pane.
¢

Left click on the show button.
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Opening a document

In a few seconds, the Introduction document appears
document editor.

In

the
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Add

Edit

File

Mail

Print

Document

Editor

Exit

Welcome to BBN/Slate TM Multimedia
Document Communication Software
A new world
In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN ISlate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN ISlate
opens a new world of communication for both you and
your work group.
Multimedia communication
With BBN ISlate, you have a powerful, integrated system
for multimedia communication:
o

o
o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated document editor, where you create
and modify documents that can contain several
media types
an electronic mail interface, which allows

Document editor

Don't worry that you can't see all of the document. You'll learn
how to move through a document in the next section.
Notice that you used the left mouse button to open folders and
files. In the next section, you use all three mouse buttons to move
through a document.
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Moving through a document
Whether creating, editing, or just reading a BBN/Slate document,
you need to know how to move around it quickly. You move
through a document using the scroll bars on the side and bottom of
the document editor.

Editor

Welcome to BBN/Slate TM Multimedia
Document Communication Software
A new world
In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN lSI ate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN lSI ate
opens a new world of communication for both you and
your work group.

Multimedia communication
With BBN ISlate, you have a powerful, integrated system
for multimedia communication:
o

o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated document editor, where you create
and modify documents that can contain several
media types

cal
Horizontal scroll bar

Scroll bars in the document editor

Most often, you'll scroll through a document vertically, or page by
page. Sometimes, though, you may have to move horizontally to
see all of a wide spreadsheet or large graphic.
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Moving vertically

Using the icons in the vertical scroll bar, you can move down and
up in a document. The next figure shows the arrows, page icon,
and edge icon in the vertical scroll bar. Notice that the icons
appear both at the top and the bottom of the scroll bar.
Ybu'll learn how to use these icons in the next few sections.
Arrows

Page icon
Edge icon
(
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Edit

. I.

File

I,

Mail

••

Print

c

Document

Editor

Welcome to BBN/Slate TM Multimedia
Document Communication Software
A new world
In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN lSI ate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN ISlate
opens a new world of communication for both you and
your work group.

Multimedia communication
With BBN ISlate, you have a powerful, integrated system
for multimedia communication:
o

o

o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated document editor, where you create
and modify documen ts that can contain several
media types
an electronic mail interface, which allows you to

Edge icon
Page icon
Arrows

Icons and scroll bubble in the scroll bar
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This figure also shows you the scroll bubble, which tells where
you are in the document. The length of the scroll bubble tells
how much of the document is visible, and the position of the
bubble within the scroll area tells which part of the document is
visible.
For instance, in this figure, the scroll bubble takes up about a third
of the scroll bar, which means that you are you are looking at
about a third of the document. The bubble is at the top of the
bar, which means that you are looking at the beginning of the
document.
Scrolling a line at

a time

First scroll through Introduction a line at a time. To move
down one line, you left click on either the top or bottom set of
arrows.
<> Left click on either set of arrows.
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Left click on either
set of arrows

.
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Welcome to BBN/Slate TM Multi
Document Communication Softw
A new world
In this age of information overload, most messag
ignored or quickly forgotten. Now that you have
BBN ISlate software, you can cu t through the cl u tt r of
daily information and communicate your informati n
and concepts more effectively. As you become
experienced using the system, you'll find that BBN
opens a new world of communication for both you
your work group.

Multimedia communication
With BBN ISlate, you have a powerful, integrated syst
for multimedia communication:
o

o
o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated document editor, where you create
and modify documents that can contain several
media types
an electronic mail interface, which allows you to

Scrolling down a line

The document scrolls down one line.
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Welcome to BBN/Slate
Document Communication
A new world
In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN lSI ate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN ISlate
opens a new world of communication for both you and
your work group.

Multimedia communication
With BBN lSI ate, you have a powerful, integrated system
for multimedia communication:
o

o
o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated document editor, where you create
and modify documents that can contain several
media types
an electronic mail interface, which allQws. you to
distribute your multimedia documents to other

After scrolling down a line

To scroll up a line, you right click on either the top or bottom set
of arrows.
~

Right click on either set of arrows.
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Right click on either
set of arrows
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Welcome to BBN/Slate TM Multimed a
Document Communication Software
A new world
In this age of information overload, most messages a e
ignored or quickly forgotten. Now that you have
BBN ISlate software, you can cut through the clutter ~f
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN IS f3.te
opens a new world of communication for both you an
your work group.

Multimedia communication
With BBN ISlate, you have a powerful, integrated systen
for multimedia communication:
o

o

o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated document editor, where you create
and modify documents that can contain several
media types
an electronic mail interface, which allows you to

, )It:.., ,; " , " , "
l'*i'i@%A*¥¥¥i¥t#4%&iit4¥$'i@.@tM Buffer: Introduction

,";d"iijil!

i:l~IO

file: Introduction.slt @t~M~4!tj&iW¥¥¥U¥&H1

Scrolling up a line

You move back up to the first line of the document.
Remember: to move down through a document, left click. To
move up, right click.
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Paging through a
document

You can page through the document by using the page icons on
the vertical scroll bar. To move down a page, you left click on
either page icon.

<> Left click on either page icon.
Left click on
either page icon
t
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Welcome to BBN/Slate TM Multimec'a
Document Communication Software
A new world
In this age of information overload, most messages e
ignored or quickly forgotten. Now that you have
BBNISlate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN IS ate
opens a new world of communication for both you a d
your work group.
Multimedia communication
With BBN ISlate, you have a powerful, integrated syste
for multimedia communication:
o

o
o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated document editor, where you create
and modify documents that can contain several
media types
an electronic mail interface, which allows you to
~[910

Paging down through a document

You move down one page.
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Print

Document
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from other software systems
a sophisticated document editor, where you create
and modify documen ts that can contain several
media types
an electronic mail interface, which allows you to
distribute your multimedia documents to other
people
an electronic conferencing system, so you can
easily collaborate with others on creating and
revising multimedia documents
a set of tools, which let you customize and expand
the BBN ISlate system to meet your personal needs
as well as the needs of your work group

Media types
BBN ISlate truly is a multimedia system because it lets
you mix several media types in one document. You are
now reading an example of a multimedia document!
All the BBN ISlate media types are briefly explained and
illustrated here:

Text

Like a desktop publishing system, BBN ISlate lets you
format text in different fonts, sizes, and type styles.
This is 10 point Helvetica in bold face.

This is 14 point TV in ita/ ie.

After moving down one page

To move up a page, you right click on either page icon.
~

Right click on either page icon.
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Document

from other software systems
o

o

o
o

an electronic conferencing system, so yo can
easily collaborate with others on creating and
revising multimedia documents
a set of tools, which let you customize an expand
the BBN ISlate system to meet your person' needs
as well as the needs of your work group

Media types
BBN lSI ate truly is a mult imedia system because it I ts
you mix several media types in one document. You are
now reading an example of a multimedia document!
All the BBN ISlate media types are briefly explained
illustrated here:

Text

Like a desktop publishing system, BBN ISlate lets you
format text in different fonts, sizes, and type styles.
This is 10 point Helvetica. in bold face.

This is 14 point TV in italic.

This is 18

Moving up one page

You move up one page.
You can use either the top or the bottom arrow or page icons to
move through a document. Remember to left click on either icon
to move down and right click to move up.
Now read through the rest of the document by paging through it.
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<)

Left click on either page icon until you reach the end.
When you reach the end, the screen will look like this:

=
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Customization

File

Mail
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Print

Document
V"

't''''

Editor

Keycaps

Exit

v, '''''' ;t'."
t'!!" ,,,,,.
With the previewer function, you can review a
document for page layout, page breaks, and line breaks
before printing.
11a, u-"':t' Y

V11

l:-

~

~

~

BBN ISlate comes with a set of tools that allow you both
to extend BBN ISlate's power and to tailor the system's
personal fit. In addition, with the built-in BBN/Slate
Extension Language (SEL), you can extend BBN /Slate's
function ali ty and further enhance your BBN /Slate
multimedia environment.

Welcome to the new world of BBN/Slate
multimedia communication!

Paging to the end of a document
Moving to the
beginning or end
of a document

Edge icons move you to the beginning or end of a document. To
move to the beginning, you middle click on the top edge icon; to
move to the end, you middle click on the bottom edge icon.
Now that you've read through the Introduction document, you
decide to re-read something at the beginning, so you move there
using the top edge icon.
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<$>

Middle click on the top edge icon.
Middle click
here
. I.

••

I

I

With the pr~viewer function, you can review a
document for page layout, page breaks, and line breaks
before printing.
Customization

BBN ISlate comes wi th a set of tools that allow you both
to extend BBN ISlate's power and to tailor the system's
personal fit. In addition, with the built-in BBN ISlate
Extension Language (SEL), you can extend BBN ISlate's
functionali ty and further enhance your BBN lSI ate
multimedia environment.

Welcome to the new world of BBN/Slate
multimedia communication!

Moving to the beginning of a document

You see the top of the document.
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Welcome to BBN/Slate TM Multimedia
Document Communication Software
A new world
In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN lSI ate
opens a new world of communication for both you and
your work group.

Multimedia communication
With BBN lSI ate, you have a powerful, integrated system
for multimedia communication:
o

o
o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated documen t editor, where you create
and modify documents that can contain several
media types
an electronic mail i

After moving to the top of the document

You can move to the end of the document

• Middle click on the bottom edge icon.
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III

the same way.
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Print

Document

Editor

Keycaps

Exit
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Printing and
previewing

Using BBN ISlate's prin ting functions, you can produce
high-quality, hard-copy output on PostScript™ printers.
With the previewer function, you can review a
document for page layout, page breaks, and line breaks
before printing.

Customization

BBN ISlate comes with a set of tools that allow you both
to extend BBN ISlate's power and to tailor the system's
personal fit. In addition, with the built-in BBNISlate
Extension Language (SEL), you can extend BBN IS Iate's
functionality and further enhance your BBN ISlate
multimedia environmen t.

~

;:::;

Welcome to the new world of BBN/Slate
multimedia communication!

/

/

Middle
click here

Moving to the end of the document

You move to the end of the document. This is the first time that
you've used the middle mouse button. Most of the time, you'll
use only the left and right buttons.
Moving
horizontally

Most of the time you only need to move up and down through a
document. If you have a wide graphic or large spreadsheet,
however, you may need to move horizontally to see the entire

Learning the Basics 2-23

graphic or spreadsheet. You can move right and left in a
document using the icons in the horizontal scroll bar.
The following figure shows the arrows, page icons, edge icons, and
scroll bubble in the horizontal scroll bar.

Add

Edit

File

Mail

Print

Printing and
previewing

Using BBN ISlate's printing functions, you can produce
high-quality, hard-copy output on PostScript™ printers.
Wi th the previewer function, you can review a
documen t for page layout, page breaks, and line breaks
before printing.

Customization

BBN ISlate comes with a set of tools that allow you both
to extend BBN/Slate's power and to tailor the system's
personal fit. In addition, with the built-in BBN ISlate
Extension Language (SEL), you can extend BBN ISlate's
functionality and further enhance your BBN ISlate
multimedia environment.

Welcome to the new world of BBN/Slate
multimedia communication!

icon

icon

Arrows

Horizontal scroll bar
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icon

Page
icon

Arrows

Like the vertical scroll bubble, the horizontal scroll bubble tells
where you are in the document. The length of the bubble tells
how much of the document is visible, and the position of the
bubble within the scroll area tells which part of the document is
visible. For example, in this figure, the scroll bubble takes up
almost the entire scroll bar, which means that you are looking at
nearly the whole width of the document.
Experiment on your own to learn to use the horizontal scroll bar.
If your document has a standard width, you can probably see most
of it without scrolling across. If you do scroll across and see a
blank screen, you can get back to the left-hand edge by right
clicking on either page icon until you see text again.
Use the following table to move across a document.

To Move

Use this Action

On this Icon

One space to the right

Left click

Arrows (either set)

One space to the left

Right click

Arrows (either set)

One page to the right

Left click

Page icon (either)

One page to the left

Right click

Page icon (either)

Right edge

Middle click

Right edge icon

Left edge

Middle click

Left edge icon

Moving across a document

Managing folders and files
After reading through the Introduction document, you decide
to put a copy in a separate folder called +New. Don't worry
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about the document currently in the document editor; you manage
folders and files from the document manager, so it doesn't matter
if a file is currently in the editor.
You create a new folder and then copy the Introduction
document into it. You also copy other files from the +Getting
Started folder into the +New folder.
Creating a
folder

To create a folder using existing documents, you select the files
you want to copy or move. You then name the new folder and
copy or move the files into it.
You are already in the +Getting Started folder, which is
where the original documents are stored. Now select the file you
want to copy and name the new folder.
V If the name Introduction isn't already highlighted, left click
on it once.
\> Erase the folder name +Getting started by placing the

cursor at the end of the name and backspacing.
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Naming the new folder
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You have named the new folder. If you want to give a folder a
two-word name, separate the two words with an underscore,
period, or other distinguishing character.
Now copy files into it by using the save button.
~

Right hold on the save button.

<t Drag right to highlight the Copy Selected Documents to
Folder option as shown in the next figure. Release .
1:
2:

N
N

. i UlTIlJlt'1 ffii. • I
08 May 90 smith
Presentation
08 May 90 smith
SalesA~ions

~
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i
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(forward)
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~

Folder: +Ne"!l..
~~( delete)

.: : : ... ..... I Move

~ (:~:~~~~~:~:)

I I

Selected Docl)..

~

..

i Ell .Tin'\

Copying a document to a new folder

This button, like all the buttons in the document manager, has an
underlying pop-up menu. When you left click on a button as you
did earlier to open folders and files, BBN/Slate automatically
selects the first option on this menu.
To select any of the other options, right hold to display the pop-up
menu. You can then choose the option you want by highlighting
the option and releasing.
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You have now copied the file Introduction to your
+New folder. Now copy the files Presentation and
SalesRegions to the +New folder. You'll use these documents in the rest of the tutorial.

Copying several
documents at
once

You can copy several documents at once by holding down the
Shift key while you select them. First, deselect Introduction
so that you don't copy it again.
¢

Middle click inside the document summary pane.
Middle click
here
~I

':"1;

;1~ri."jF.l1 o);;~iI'i1r,

1:

2:
3:

N
N
N
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Presenta tion
SalesRegions
Introduction

) ( cancel )

,D,,';

,..

/

( done )

(forward)

(new mail)

( print )
( sort )
( select )

( filter )

( conf )

ilE"

+Getting Started
+Mailbox
+New
+demo

~

~

~

\,'1
,..
~

Folder: +Ne"1.

( next

)(

reply

)(

delete )

( folder ) ( save )

Deselecting a document name

The Introduction document is no longer highlighted.
select the other two documents.

Now

'1>

Hold down the Shift key.

~

Left click on the names Presentation and SalesRegions
in the folder listing.

~

Right hold on the save button.
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<;- Highlight the Copy Selected Documents to Folder

option. Release.

~

(compose)~( cancel)

~

(forward)

(new mail)

~
~
~

~

~

+Mallbox
+New
+demo

Folder: +Ne"!!..

C§D~~

~

Copying more than one document

To check that you copied them correctly, display the contents of
the +New folder. Earlier, you opened a folder by highlighting its
name and clicking on the folder button. This time, use a shortcut
and double-click on the folder name to open it.
¢>

Using the left button, double-click on the name +New in the
folder list.
All three files now appear in the document summary screen.
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Contents of a newly created folder

To make sure that you copied the documents correctly, take a look
at one of them. Use the same shortcut to open the document.
~

Using the left mouse button, double-click on the name
Introduction.
The copy of Introduction appears in the document editor.
Because you didn't alter the original Introduction document,
BBN/Slate removes it from the editor.

Going on to the next chapter
Moving on
immediately

If you aren't taking a break before moving on to the next chapter,
leave the Introduction document in the document editor. You
can skip over the rest of the next section and go on to the last
section, called "What you've learned. II

Optionally exiting

You may want to rest before going on to Chapter 3. To leave
BBN/Slate completely and then come back to the tutorial, first exit
the document editor.
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To exit from the document editor, right hold on the Exit menu.
Drag down to select the Exit option and release.
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Welcome to BBN/Slate TM Multimedia
Document Communication Software
A new world
In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you/II find that BBN /Slate
opens a new world of communication for both you and
your work group.

Multimedia communication
With BBN /Slate, you have a powerful, integrated system
for multimedia communication:
o

o

a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems
a sophisticated document editor, where you create
and modify documents that can contain several
media types

Exiting from the document editor

The document editor closes. Next exit from the document
manager by clicking on the done button.
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Exiting from the document manager

Your window manager iconifies the document manager and places
it on your desktop. You can now either exit from your windowing
system or stay within your windowing system and continue to
work in other programs.

\I\!hai you've learned
In this session, you learned how to:

•

start BBN/Slate

•

open a folder

•

open a document

•

copy files from one folder to another

You will use these skills in your everyday work as well as in the
rest of this tutorial. In the next chapter, you learn how to create
text documents inside the document editor.
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3
Reading through the Introduction document has made you
excited about the possibilities of BBN/Slate. Your presentation on
Project Saturn has given you the perfect opportunity to tryout the
software.
You are to present Project Saturn at a company meeting in only
three days. Normally, you would have protested that three days
was not enough time to put together a presentation. After all, the
colleagues you need information from are located across the world.
But like you, these people also have BBN/Slate. Exchanging
complex information with them will now be as simple as sending
an electronic mail message.
You start by drafting an outline. In later chapters, you'll send this
outline to your colleagues for feedback. During this work session,
you:
work with text

•

learn how to get help from BBN/Slate
store a document

Before you begin

If you exited from BBN/Slate at the end of Chapter 2, first
re-enter the system. From your operating-system, get into
BBN/Slate as you did at the beginning of Chapter 2.
If you iconified the document manager, left click on the icon to
re-enter the system.

Creating a Text Document 3-1

Left click on this
icon to re-enter
BBN/Slate from the
desktop

Re-entering BBN/Slate

The document editor and document manager then appear.
Making sure you
are in the correct
folder

Before beginning, make sure that you are in the +New folder.
Double-click on the name +New in the folder list to be sure you
are in the correct folder.

(} Using the left mouse button, double-click on the name +New in
the folder list.
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Double-click here

Making sure you are in the +New folder
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Working with text
To create your outline, you open a new file and begin typing in
text.
Opening a
new file

To open a new file, you use the compose button in the command
pane and select the type of document you want to compose.
¢> Right hold on the compose button in the document editor.
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Right hold here to display a pop-up menu

The compose pop-up menu

This pop-up menu lets you choose the type of document you want
to compose. If an option on a pop-up menu is followed by an
arrow, that option leads to another menu, called a submenu. You
access a submenu by dragging further to the right until the
submenu appears.
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~

Drag right to highlight the From System Template option .

• Drag further right to highlight the standard-doc option
from the submenu .
• Release.

I .
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on
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QuickStart
arabic-template
classified -doc
complex -doc
hangul-template
hebrew-template
memo
simple -doc
slate-bug
slate-wish

( save )

Selecting a standard document format

A blank buffer appears in the document editor. A buffer is a
temporary storage area where you work on your document before
storing it in a file.
The name of the buffer (in this case standard-doc) and the
name of the file appear at the bottom of the document editor.
Since you have just opened this document and have not saved it to
a file yet, you see no file name at the bottom of the editor.
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File

Mail

Print

Buffer name

DOGument

Exit

File name

Blank buffer in the document editor

The standard-doc option is a template. BBN/Slate comes with
several templates, or documents containing certain text styles,
which you can use over and over again. When saving a document
created from a template, you save only the document itself. The
template remains blank so that you can use it again. You can also
create your own templates. See the BBN/Slate Reference Manual
for information on creating templates.
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You can begin entering text. Start by creating an opening
paragraph for your outline.

Entering text

~

Move the pointer inside the document editor window.
Placing the pointer inside the window makes it active. You can't
work in a window unless it is active.

~

Right hold inside the document editor to bring up the Text
menu .

....

-

Add

Edit

File

Mail

Print

Text
=:>
Add
Fonts
=:>
Language
=:>
Styles
=:>
Edit
=:>
Counters
=:>
Group
Ungroup
Search ...
Select
=:>
Lists
=:>
Describe Item ...

Bringing up the Text menu
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Document

~

Editor

Exit

The Text menu is a pop-up menu that appears whenever you
right hold inside a text area. Each media type - including text,
graphics, spreadsheets, and others - has its own pop-up menu.

<> Highlight the Add option, and drag right to display the next
submenu.
Notice all of the options you have on this submenu. Each of these
options, from caption-f igure to itemization, represents a
text style. BBN/Slate has lots of different text styles, and you can
also create your own.
~

Highlight the noindent option. Release.
Text

I' :',

1m

caption -figure
caption -table
Fonts
Language
center
chapter
Styles
Edit
example
Counters
item tag
Group
1JiTi1ri1i ~ t:~=~
paragraph
Ungroup
right
Search ...
Select
section
subsection
Lists
Describe Item. subtitle
table
title
toc-body1
toc-body2
toe-title
usertag
verbatim
description
enumeration
itemization

10'·

Selecting the noindent style

The cursor appears on the margin.
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Cursor ready for text

<> Type in the following text:
Easy to learn and to use, Project Saturn should
become a bestseller.
Project Saturn is a
software package that runs on most workstations.

The text should look something like this:

Add

Edit

File

Mail

Print

Document

Editor

Easy to Igarn and to USg, Projgct Saturn should become a bgstsgl!gr. Projgct Saturn
is a software package that runs on most workstations ......

Typing a paragraph
Correcting
mistakes

If you make any mistakes, you can correct them using the Delete
or Backspace key. If you find a mistake after typing in the whole
paragraph, you can move back to the mistake using the arrow keys
or by pointing and clicking with the left mouse button.
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For example, if you had misspelled the word package as in the
following figure, you would move the pointer inside the document
editor and left click after the mistake.

""'"
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Edit

File

Mail

Print

Document

Editor

Keycaps

Exit

Easy to learn and to use, Project Sa turn should become a bestseller. Project Sa turn
is a software pcakg~that runs on most workstations.

Correcting a misspelled word

You would then press Backspace or Delete to delete the incorrect
letters, and type in the correction.

-.. 'I
~

Add

Edit

File

Mail

Print

Document

Editor

Keycaps

Exit

Easy to learn and to use, Project Sa turn should become a bestseller. Project Sa turn
is a software packag~that runs on most workstations.

Typing in the correct letters
Adding a
heading

After you type in the paragraph, you think of an idea for a
heading and decide you want the heading centered.
~ Place the cursor before the first word in the paragraph by

pointing and left clicking.
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iasy to learn and to use, Project Sa turn should become a bestseller, Project Sa turn
IS a software package that runs on most workstations,

Placing cursor at the beginning

You've placed the cursor at the very beginning of the document
and are ready to enter the centered heading.

<,

Right hold inside the document editor to bring up the Text
menu.

<)

Highlight the Add option, and drag right to display the next
submenu.

<)

Drag right and down to highlight the Center option.
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kasy to learn and to use, Project Saturn should become a bestseller. Project Saturn
IS a software package that runs on most workstations.

Text
11lI':

I

if"

Fonts
Language
Styles
Edit
Counters
Group
Ungroup
Search ...
Select
Lists
Describe Item.

1lI
caption -figure
caption -table
l'i1:-ffi, -

chapter
example
itemtag
noindent
paragraph
right
section
subsection
subtitle
table
title
toc-body1
toc-body2
toe-title
usertag
verbatim
description
enumeration
itemization

Adding centered text

<> Release.
The cursor moves to the center of the line, and you are ready to
enter the text of the heading.

Creating a Text Document 3-11

....
!:::!::

Add

Edit

File

Mail

Print

Document

Editor

Easy to learn and to use, Project Sa turn should become a bestseller, Project Sa turn
is a software package tha t runs on most workstations,

Cursor ready for centered text
~

Type in the text for the heading, as shown below:
Saturn: Up and Coming in a Growing Market

As you type, BBN/Slate centers the text in the middle of the line.
When you are finished, the heading should look like this one:

Mail

Print

Document

Editor

Keycaps

Exit

Saturn: Up and Coming in a Growing MarkeSl
Easy to learn and to use, Project Sa turn should become a bestseller, Project Sa turn
is a software package that runs on most workstations,

After adding a centered heading
Adding a
list

You are ready to begin your outline. Because your ideas are
sketchy, the outline will not be very formal or detailed. You start
by making a list of the three major points you want to make at the
presentation.

<> Place the cursor at the end of the paragraph and left click.
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Sa turn: up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller. Project Sa turn
is a software paCkage that runs on most worksta tions.ll..

~

~

~r

~
~

Cursor before beginning a list

~ Right hold to bring up the Text menu.

Drag down to
highlight Add, then drag right and down to highlight
enumeration. Release.
Text

m

caption -figure
Fonts
caption -table
Language
center
Styles
chapter
Edit
example
Counters
item tag
Group
noindent
Ungroup
paragraph
Search ...
right
Select
section
Lists
subsection
Describe Item. subtitle
'.:<""
table
title
toc-body1
toc-body2
toe-title
usertag
verbatim
description

W:

I

IE;',

iTi

,"

itemization

Adding an enumerated list

The number 1 appears automatically in the left margin. If you
didn't select the correct text style and do not see a number 1 on
the margin, press the Backspace or Delete key until you return to
the end of the paragraph and then begin again.
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In addition to enumerated lists, BBN/Slate has lists beginning with
descriptions (description) and bullets (itemization). You
can also create your own list styles.
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Print

Document

Editor

Exit

Sa turn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller.
is a software package that runs on most workstations.

1.

Project Sa turn

J..

Cursor ready to begin a list

Now type in the three major points.

<> Type in the list of points as shown below: At the end of each
list item, press Return:
How does Project Saturn stack up against the competition?
<RET>
What are our forecasted sales in Europe? <RET>
How can we achieve these forecasted sales? <RET>
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Saturn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller. Project Sa turn
is a software package that runs on most workstations.
1.
2.
3.
4.

How does Project Saturn stack up against the competition?
What are our forecasted sales in Europe?
How can we achieve these forecasted sales?
l..

Typing in an enumerated list

When you press Return, the number for the next list item appears.
After you press Return following the third item, a number 4
appears. Since you only want three items, end the list here.

<> Press Return once more to end the list.
"

Add

Edit

File

Mail

Print

Document

Editor

l(e~lcaps

Exit

Saturn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller. Project Sa turn
is a software paCkage that runs on most workstations.
1.
2.
3.

How does Project Sa turn stack up against the competition?
Wha t are our forecasted sales in Europe?
How can we achieve these forecasted sales?

Ending a list

Notice that the last number (in this case, 4) is now gone. You can
end any list by pressing Return twice.
Embedding
lists

Now that you have the major points sketched out, you are ready to
add some subpoints. With BBN/Slate, you can easily embed lists
within lists.
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Start by adding three subpoints below the first major point.
~ Place the cursor at the end of the first list item.

Left click.

~ Right hold to bring up the Text menu.

Drag down to
highlight Add, then drag right and down to highlight
enumeration. Release.
!~~
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DOGument

Editor

Saturn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller, Project Sa turn
is a software package that runs on most workstations,
1,

How does Project Saturn stack up against the competition~

2,

What are our forecasted sales in Europe?

3,

How can we achieve these forecasted sales?

language
Styles
Edit
Counters
Group
Ungroup
SearGh,.,
SeleGt
lists
DesGribe Item,

Gaption -table
Genter
Ghapter
example
itemtag
noindent
paragraph
right
seGtion
subseGtion
subtitle
table
title
tOG-body1
tOG-body2
tOG-title
usertag
verbatim

I~IIIIII enumeratiomli.
desGription

m

itemization

Adding an embedded list

A new line appears beginning with the letter A.
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Sa turn: Up and Coming in a Growing Market
Easy to learn and to use, Project Saturn should become a bestseller, Project Saturn
is a software package that runs on most worksta tions,
1,

How does Project Saturn stack up against the competition?
A,

2,
3,

..L

What are our forecasted sales in Europe?
How can we achieve these forecasted sales?

Cursor ready for an embedded list

Now enter the text of your subpoints.

o Type

in the text of subpoints A, B, and C as shown below. At
the end of each list item, press Return:
Available on multiple workstations <RET>
Consistent look and feel <RET>
Easy to learn <RET>

The text should look like the list

In

the next figure.
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Sa turn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller.
is a software package tha t runs on most worksta tions.
1.

Project Sa turn

How does Project Saturn stack up against the competition?
A.

Available on mUltiple workstations

B.

Consistent look and feel

C.

Easy to learn

D. •
2.

What are our forecasted sales in Europe?

3.

How can we achieve these forecasted sales?

Embedding a list

When you press Return at the end of subpoint B, you added a
third subpoint. You delete it using the Delete key.

\> Press the Delete key to get rid of the letter D.
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Exit

Saturn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller.
is a software paCkage that runs on most workstations.
1.

How does Project Saturn stack up against the competition?
A.

Available on mUltiple workstations

B.

Consistent look and feel

C.

Easy to learlJl..

2.

What are our forecasted sales in Europe?

3.

How can we achieve these forecasted sales?

Ending an embedded list
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Project Sa turn

If you ended the sub list by pressing Return twice, you have an

extra line in between subpoint C and point 2. Delete it by
pressing the Delete key.
While adding the subpoints to number 1, you thought of another
main point. You make it the new third point.

Adding to
the main list

<)

Place the cursor at the end of the second major point. Left
click.

¢ Press Return to add a new list item.

i~~
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Editor

Exit

Saturn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller. Project Sa turn
is a software package tha t runs on most workstations.
1.

2.

3.
4.

How does Project Saturn stack up against the competition?
A.

Available on mUltiple workstations

B.

Consistent look and feel

C.

Easy to learn

What are our forecasted sales in Europe?

...
How can we achieve these forecasted sales?

Adding a new list item
~

Type in the text shown below. When you reach the end, don't
press Return:
What are our forecasted sales in the United
States?

When you are finished, the list should look like the one in the
following figure.
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Saturn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller. Project Sa turn
is a software package that runs on most workstations.
1.

2.

How does Project Sa turn stack up against the competition?
A.

Available on mUltiple worksta tions

8.

Consistent look and feel

C.

Easy to learn

What are our forecasted sales in Europe?

3.

What are our forecasted sales in the United Sta tes~

4.

How can we achieve these forecasted sales?

Adding to the main list

This time you ended a list item by not pressing Return. If you
did press Return, you can delete the new number 4 by pressing the
Delete or Backspace key.
Notice that the system renumbers the list items. Your new list
item automatically becomes number 3, and the old number 3
becomes number 4.
Cutting and
pasting text

You read what you've produced so far. It looks fine, but the first
paragraph isn't quite right. You decide to move the second
sentence to the beginning of the paragraph .

• Place the cursor at the beginning of the second sentence. Left
drag all the way to the end of the paragraph. Release.
The second sentence is highlighted. Whatever option you choose
now will affect only the highlighted text.

3-20 BBN/Slate Getting Started

File

Mail

Print

DOGument

Editor

Sa turn: Up and Coming in a Growing Market
Easy to learn and to use, Project Saturn should become a bestseller.
1.

2.

,ji!)rn'1...'tnm~

How does Project Saturn stack up against the competition?
A.

Available on mUltiple worksta tions

B.

Consistent look and feel

C.

Easy to learn

What are our forecasted sales in Europe?

3.

What are our forecasted sales in the United States?

4.

How can we achieve these forecasted sales?

Highlighting text

Now cut the text using the Edit-Cut option from the Text
menu.
<)

Right hold to bring up the Text menu. Drag down to
highlight the Edit option, then drag right to highlight the Cut
option. Release.
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Saturn: Up and Coming in a Growing Market
Easy to learn and to use, Project Sa turn should become a bestseller .
I$i'~lsoft:ware)

1.

How does Project S3-turn stack up against the competition?

2.
3.

Text
Add
C.
Fonts
Wha Language
Wha Styles

4.

How I ..

A.

..'jli!ltitiJI'%lIDili1illl

acka e"thatllruns'ommost'liWorkStatlons.

Available on multiple workstations

B.

=:.
=:.
=:.
=:.

feel

sales in Europe?
;alesin the United St, t es?
'"

Counters
Group
Ungroup
Search ...
Select
Lists
Describe Item ..

...

Copy
Clear
Paste
Copy To Selection
Paste From Selection
Split
Transliterate

Cutting text
The text disappears. Now paste the text at the beginning of the
paragraph.
~

Place the cursor at the beginning of the paragraph. Left click.

<> Right hold to bring up the Text menu. Drag down to
highlight the Edit option, then drag right to highlight the
Paste option. Release.
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Saturn: Up and Coming in a Growing Market
.£asy to learn and to use, Project Saturn should become a bestseller.

1.
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menu item.

Pasting text

The text appears in its new position. By cutting the text, you
placed it on a temporary clipboard, or storage area. When you
pasted the text, you retrieved it. The clipboard can hold one item
at a time (i.e. one chunk of text, one spreadsheet, or one graphic)
and replaces it with the next item you cut or copy.
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Sa turn: Up and Coming in a Growing Market
Project Saturn is a software package that runs on most workstations.fasy to learn
and to use, Sa turn should become a bestseller.
1.

2.

How does Project Sa turn stack up against the competition?
A.

Available on mUltiple workstations

B.

Consistent look and feel

C.

Easy to learn

What are our forecasted sales in Europe?

3.

What are our forecasted sales in the United States?

4.

How can we achieve these forecasted sales?

Document with pasted text

Now add two spaces to separate the two sentences.
(1 Press

the Spacebar twice.

The paragraph should now look like this:
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Sa turn: Up and Coming in a Growing Market
Project Saturn is a software paCkage that runs on most workstations . .I:asy to
learn and to use, Sa turn should become a bestseller.
1.

2.

How does Project Saturn stack up against the competition?
A.

Available on multiple workstations

B.

Consistent look and feel

C.

Easy to learn

What are our forecasted sales in Europe?

3.

What are our forecasted sales in the United States?

4.

How can we achieve these forecasted sales?

After adding spaces
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Editing the
text

The first sentence doesn't sound quite right yet, so you edit it.
~ Left click before the word "Proj ect" in the first sentence.
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Saturn: Up and Coming in a Growing Market
project Sa turn is a software package that runs on most workstations.
Tearn and to use, Saturn should become a bestseller.
1.

2.

Easy to

How does Project Sa turn stack up against the competition?
A.

Available on multiple workstations

B.

consistent look and feel

C.

Easy to learn

What are our forecasted sales in Europe?

3,

What are our forecasted sales in the United States?

4,

How can we achieve these forecasted sales?

Document after deleting text

Type in a new beginning,
¢ Type in the following text:
The most recent addition to our product line,

¢ Press the Spacebar once.
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After editing, the first paragraph should look like this:
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Sa turn: Up and Coming in a Growing Market
The most recent addition to our product line,l'roject Saturn is a software package
that runs on most workstations. Easy to learn and to use, Saturn should become a
bestseller.
1.

How does Project Saturn stack up against the competition?
A.

Available on multiple workstations

B.

Consistent look and feel

C.

Easy to learn

2.

What are our forecasted sales in Europe?

3.

What are our forecasted sales in the United States?

4.

How can we achieve these forecasted sales?

Document with new text
Changing
the type style

Now that you have the content of your outline finished, you want
to improve the way it looks. You decide to change the type style
of the entire document.

V Right hold on the
editor.
Release.

Document menu at the top of the document
Drag down to highlight Set Language/Font.
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Saturn: Up and Coming
The most recent addition to our product Iirl-m!lWl!i!~_I!iIII!!I~_I!iIII!!I!f!Ml~
that runs on most workstations. Easy to learn a
bestseller.
1.

How does Project Sa turn stack up against the competition?
A.
S.

Available on multiple workstations
Consistent look and feel

C.

Easy to learn

2.

What are our forecasted sales in Europe?

3.

What are our forecasted sales in the United Sta tes?

4.

How can we achieve these forecasted sales?

Changing the document font

The menus that appear on the menu bar at the top of the document
editor control the entire document. Think of the menu bar as a
control panel for the whole document and the pop-up menus inside
the editor as control panels for individual media types.
You can select menus from the menu bar using either the left or
right mouse button. Use the button that feels comfortable to you.
When you select the Set Language/Font option, a dialog box
appears on the screen. BBN/Slate uses dialog boxes to prompt you
for the information it needs to do a particular task.
In this case, BBN/Slate asks you to set the language and font for
the entire document. If you have the Multilingual Option, you
could use this menu to set the language script (such as Russian or
Hebrew) of the document. Right now, you are only using it to set
the font family and font size.
~

Left click on the cycle button beside Family until you see
timesroman appear.
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l

Document Language
Language C English
Paragraph Flow: Left-to-Right

F~ ~
C

I---- Left click
here

Document
Family
....... elvetica
Face
Normal
Size
C 10 pt

o Underlined
[(

DK

]

Cancel)

Changing the font family

You can select items from a cycle button by left clicking until the
choice that you want appears, or you can display a menu by right
holding on the cycle button.

<> Right hold on the cycle button beside Size to display a
pop-up menu. Drag right to highlight 12 pt. Release.

<> Left click on OK.
Document Language - - - - - - ,
Language C English
Paragraph Flow: Left-to-Right
Document Font
Family
Face
Size

[(

DK

)]

;:;;:=:::;---l

(cancel)

Right hold
here to display
pop-up menu

Changing the font size

The text in the entire document now appears in a different font.
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Next, you continue to enhance the look of the document by
making the centered heading larger and boldface.

Editing the
heading
~

Place the cursor at the beginning of the heading. Left click.

~

Right hold to display the Text menu. Drag down to highlight
Styles. Drag right to highlight Local Change and then
center. Release.

Add

Edit

File

Mail

Print

Document

Editor

liaturn: Up and Coming in a Growing Market
The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.
1.

How Text
A.

B.
C.

2.
3.

4.

Add
Fonts
Language

=:>
=:>
=:>

n stack up against the com peti tion?
tiple workstations
iTirn!i[tliF.1 ••

,~'Cl1Til':l'i1

mill ..

Edit
Global Change
Counters
Remove Changes
=:> ?
Wha Group
Create
Switch
Wha Ungroup
ted St ates?
=:>
Search ...
Delete
How Select
les?
=:>
Lists
Describe Item ...

Changing a text style locally
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A dialog box appears. This dialog box contains information about
the text style center. Because you are making a local (rather
than a global) change to the text style, any changes you make in
this dialog box affect only the instance of the text style at the
cursor.
Change the type face and size by clicking on the Face and Size
cycle buttons.
~

Left click on the Face cycle button until Bold appears.

¢ Left click on the Size cycle button until 14 pt appears.
¢

Left click on the
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OK

button.

Left click
here twice

/
IName: cen~r

/

Left click
here once

/

/

I IBased on: verbatim

IHelp: and /'capl'tion-table" styles which are centered captions for figures and tables./
Font

/

~esroman

Family
Face ....., ormal
Size """ 12 pt
D Underlined

~'~

I ~'

'.~

1 inch

Page break
Orphan: 1..
2

C

D Width derived
D Keep with Nel<t
None
Widow: 1

3

4

5

6

7

I..~' 'J' I ' , , , I ' , , , I ' , , , I ' , , , I ' , , , I ' , , , I ' , , , I ' , , , I ' , , , I ' , , , I ' , , , ~

left Margin: Oi
Right Margin: Oi
Spacing

5iWord wrap
DKeep

3

10= = [CJ

Indent:
Oi
linewidth: Oi

I
I--~-

White Above: Oi
White below: 11

I

I

Justification

---

language C English
Paragraph Flow: left -to -Right

ITab stops: 0.5i
I Content:
IPrint Values:
INext Style:
[(

OK

))

(Cancel)

I

I
Left click here
when you
are finished

Changing the type size and face

The larger, bolder heading appears.
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l)aturn: Up and Coming in a Growing Market
The most recent addi tion to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.
1.

How does Project Saturn stack up against the competition?
A.
B.
C.

2.
3.
4.

Available on m ul tiple workstations
Consistent look and feel
Easy to learn

What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
How can we achieve these forecasted sales?

Document with enlarged heading

Accessing onmiine help
Satisfied with your new document, you are ready to store it and
take a coffee break. You aren't sure how to store your document,
so you use BBN/Slate's help system.
To get help, use the middle mouse button. You can middle click
on menus, menu options, and buttons to find out what each does.

Getting help

~

Middle hold on the Edit menu on the menu bar.
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If-_ _A_d_d__&ijt--'..--i

Cut, copy, paste, or modify display attributes for the
selected region of a document.

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.
1.

How does Project Saturn stack up against the competition?
A.
B.
C.

2.
3.
4.

Available on multiple workstations
Consistent look and feel
Easy to learn

What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
How can we achieve these forecasted sales?

Getting help on the Edit menu

You see a help message explaining that the options under the
Edi t menu cut, copy, paste, and modify display attributes.
Because you don't see anything about storing, you look for help
on another menu.
¢> Release.

<> Middle hold on the File menu on the menu bar.
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Add

Edit

flIe

Create, load, and store documents.

l)aturn: Up and Coming in a Growing Market
The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should be come a bestseller.

1.

How does Project Saturn stack up against the competition?
A.
B.
C.

2.
3.
4.

Available on multiple workstations
Consistent look and feel
Easy to learn

What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
How can we achieve these forecasted sales?

Getting help on the File menu

The help message tells you that you can use the File menu to
store documents.

o Release.
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Storing a document
When you work on a file, you work on a copy of it in a buffer
rather than on the file itself. After you've finished editing it, you
can store your changes to the file or abandon the changes. After
using the help system, you know that you use the File menu to
store documents.
To save a document, you use the Write-New File option under
the File menu.

Saving a
document
<)

Right hold on the File menu on the menu bar.

(> Drag down to highlight the Write option, then drag right to

highlight the New File option. Release.

";,;"

Add

Print

li at

Document

~';"::;;':;::;:""'~~~!!;!-l1.lL~

a Growing Market

1~=!:l~~!~:::1line,

The most recen
package that ru~S
should become a bestsell
1.

Project Saturn is a software
to learn and to use, Saturn

How does Project Sb!MIIa!Wfl\!!illlFl~:fainst the competition?
A.
B.
C.

2.
3.
4.

Editor

Available on multiple workstations
Consistent look and feel
Easy to learn

What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
How can we achieve these forecasted sales?

Saving a file

You see a dialog box that asks you to type in the name of the new

file.
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Write to file:

(

list

[

OK

)]

(Gancel)

Dialog box for saving a file

You name the file Outline by typing the name in the dialog
box. BBN/Slate accepts names in upper or lower case or any
combination of the two .

• Type in the name Outline .
• Left click on the OK button.
Write to file:

putlinll.
list)

[

OK

)]

( Gancel )

Naming a file

In many dialog boxes, including this one, you can press Return
instead of clicking on OK.
Your outline is saved in a file called Outline in your +New
folder. Keep the outline in the document editor because you will
work on it in the next chapter. If you want to exit from
BBN/Slate before moving on to the next chapter, leave the system
as described at the end of Chapter 2.
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What you've learned
As you created your outline, you learned how to:
enter and edit text
•

cut and paste blocks of text
change text fonts and sizes
get help

•

save a document

You've also learned how to use the mouse buttons to select text
and menus within the document editor. In the next chapter, you'll
mail the document you just created.
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4

Using Electronic

Mai~

After finishing your outline, you decide to send it to a colleague
who works on Project Saturn and ask for a review of the structure.
In this chapter, you:
•

send a document which includes some additional comments for
your colleague

•

compose and send a new message

•

receive mail

Because you are working in an imaginary scenario, you can't
really send electronic mail messages to people working on Project
Saturn. Instead, you'll send the messages to yourself. In the real
world, you would replace your own name in the electronic mail
header with the name of a real recipient.
Before you begin

Before beginning, make sure that you are in the +New folder and
that the document Outline which you created in the last chapter
is displayed in the document editor.
If you exited BBN/Slate at the end of the last chapter, first re-enter
the software as shown at the beginning of Chapter 3. Then open
the +New folder and the document called Outline.

Sending a document
You want a colleague to take a look at your outline on Project
Saturn. Before sending it, you need to add a few additional
comments for your colleague.
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If you send this document now, your colleague probably won't
know why you've sent it. You add some comments to explain the
outline by selecting the Add-noindent option from the Text
menu. This option tells the text editor to add a new text style, in
this case, a style called noindent. The noindent style is a
paragraph block without an indented first line.

Adding
explanatory
comments

<> Left click at the beginning of the centered heading.
~~

Right hold to bring up the Text menu. Highlight the Add
option, then highlight the noindent option. Release.
Text
111: I I ,
Fonts
Language
Styles
Edit
Counters
Group
Ungroup
SearGh ...
Select
Lists
Info ...
'."

'.

~."

I!!
caption -figure
caption -table
center
chapter
example
item tag
l"iTi1riTi ~ ~'~~;::~
paragraph
right
section
subsection
subtitle
table
title
tOG-body1
tOG-body2
tOG-title
usertag
verbatim
description
enumeration
itemization

Adding a new text style

The cursor is ready for you to enter your text.
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Mail
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Editor

Exit

Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.
1.

How does Project Saturn stack up against the competition?
A.

B.
C.

2.
3.
4.

Available on multiple workstations
Consistent look and feel
Easy to learn

What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
How can we achieve these forecasted sales?

Cursor ready for comments
~ Enter the following comments:

Sal-- <RET>
Project Saturn is really on a roll.
I'm giving a
presentation on how Saturn stacks up against the
competition at a company meeting in just three days.
Since this is your subject area too, can you give me
some feedback on this outline? <RET>
<RET>
Thanks-- <RET>
Your name <RET>
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After adding the comments, your outline should look like the one
below. Note that the user's name in this case (and throughout this
chapter) is Chris Smith.

_

Add

Edit

File

Mail

Print

Document

Editor

Project Saturn is really on a roll. I'm giving a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?
Thanks-Chris Smith...l..

Saturn: Up and Coming in a Growing Market
The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.
1.

How does Project Saturn stack up against the competition?
A.

B.
C.
2.
3.
4.

Available on multiple workstations
Consistent look and feel
Easy to learn

What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
How can we achieve these forecasted sales?

.j

Outline with explanatory text
Sending the
message

After adding the explanation, you are ready to send the outline.
To send a message already in the document editor, you use the
Send option from the Mail menu on the menu bar.

\> Right hold on the Mail menu on the menu bar. Highlight the
Send option, then highlight the Send as Multimedia
option. Release.
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Add

Edit

Project Saturn is r
a presentation on how
Saturn stacks up
ree days. Since this is
your subject area to~:;::S~F!f'@!!~5W@M~~1@fuack on this outline?
Thanks-Chris SmitlJi..

Saturn: Up and Coming in a Growing Market
The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.
1.

How does Project Saturn stack up against the competition?
A.
B.
C.

2.
3.
4.

Available on multiple workstations
Consistent look and feel
Easy to learn

What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
How can we achieve these forecasted sales?

Sending a multimedia mail message

Usually, you use the Send as Multimedia option when you
are sending a document containing media types other than text.
Here, you send a text message as multimedia just for practice.
BBN/Slate attaches a mail header to your outline and displays a
dialog box in which you enter information. This is the
information BBN/Slate needs to deliver your messages.
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Add

Edit

File

Document

Editor

Project Saturn is really on a roll. I'm giving a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?

~~I;To=:=.============================================~
ISubject:

Icc:
Alterna te fields (name: value)

r-----------------------------------,

T
p

I:

}======;

I:

~=====il:

((

OK

]

(cancel)

Document with mail header and dialog box
Filling out

a mail header

When you fill out a mail header, you tell BBN/Slate who to send
the document to. You can also add a subject line and send copies
to other people. You enter this information in fields.

<> Type in your own user name in the

To

field. Press Return.

Normally, you would type in the name of the person to whom you
want to send the document. In this exercise, you send all mail to
yourself.
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~

Type in the following subject line. Press Return:
Outline for Project Saturn presentation <RET>

The mail header should now look something like this.
Type in your own username here

ISubject:

Outline for Project Saturn presentatiol).

ICC:
Alternate fields (name: value)

I:

.-----------------------------~

~====:I:

i=====il:

IT

OK

)]

(Cancel)

Filling out a mail header

You don't want to send copies to anyone, so you leave the CC
field blank.
The alternate fields listed below the cc field give you space to
create your own categories in the mail header. For instance, you
might want to rank the urgency of your mail by creating an
Importance field similar to the Subject and Cc fields. You
could then identify a high priority message by labeling it
URGENT, as shown in the following figure. (Following a
standard UNIX electronic mail convention, you should start any
personal fields such as this one with an x-.)
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ITo: smith
I Subject: Outline for Project Saturn presentation
Icc:
Alternate fields (name: value)
I X-Important
I: '"IU'""R""GE::;"N""Tt,,-'----------------,

I

I: I

~I======~I:I~==========================~

I
I: I
I~======~I: ~============================~

P=I====~I:

I

I:

~I======~I:

Ii==========iI:

'-1_ _ _-'1:
((

OK

)]

(cancel)

Filling in alternate fields

You don't want to add any alternate fields to this message, so you
leave them blank.

<> Left click on OK to finish the header.
The dialog box disappears, and BBN/Slate displays a status
message at the bottom of the document editor telling you that it is
sending the message. If BBN/Slate is unable to send the message,
you will see an error message giving you the reason.
After sending the message, the system redisplays the message and
its attached mail header. This header contains the sender's name,
the date, the recipient's name, the subject line, and the names of
anyone receiving copies.
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Add

From:
Date:
To:
Subject:
Cc:

Edit

File

Mail

Print

Document

Editor

"Chris Smith" <smith>
Wed, 16 May 90 14:36:01 EDT
smith
Outline for Project Saturn presentation

Sal-Project Saturn is really on a roll. I'm giving a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?
Thanks-Chris Smith

Saturn: Up and Coming in a Growing Market
The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.
1.

How does Project Saturn stack up against the competition?
A.

B.
C.

Available on multiple workstations
Consistent look and feel
Easy to learn

Message with attached header

You can leave the message in the editor as you go on to compose
a new message.

Your outline is now out in the world, getting a review. You can
turn your attention to other parts of the presentation. After
thinking about the information you need in the presentation, you
decide that a colleague in Lisbon might have suitable facts and
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figures. Since this colleague also has BBN/Slate, you send a
BBN/Slate message.
To send a message, you use the compose button to bring up a
standard mail message template, fill out the mail header, compose
the message, and send it.
To compose a new message, you use the compose button
document command pane.

Composing a
new mail
message
~

III

the

Left click on the compose button in the document and folder
command pane.

Introdu '
Presenta
SalesRe

u
U
fic,;:"1::

31Z·C;:;;:O:J::;,'/

...

:;r,;~.;;;; .;t::;;;

," :-;, 1::,: ,:~:;) =:L ~ 1; .:'::::

+Ge~ting

( show)

( done)

(forward)

(new mail)

a mi,'ti1.j\;%';> i,JlM'jJ

( print)

( filter)

+demo

(

sort

)

( select)
(

conf

Started ;

+Ma.lbox

)

Folder: +Ne"!!..
(

next

) ( reply ) ( delete )

(-f~o;-;-Ide-r~)

save

)

Using the compose button

The document editor is now split into two buffers A blank mail
message appears in the top buffer (called #c ompo s e), and the
blank buffer where you were working remains in the bottom.
After you send the message, the #compose buffer will disappear
and you will be returned to the buffer you were working in.
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Add

Edit

File
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Mail

Print

Classify

Document

Editor

Keycaps

Exit

To:
Subject:
Cc:

ITo:.1..
ISubject:
Icc:
Alternate fields (name: value)

I:

r---~------------------------------,

P=====jl:

..

I:

~====:I:

p

~"'=(=O=K=]

(cancel)

S~~~~~~~~~~~~~~~~~~~~~~~

your subject area t~o, can you give me some feedback on this outline?

~

.,.."

~...

Buffer: standard-doc File: Outline.slt
r-'lIOUIe button Oescrlbes !l!e Item under !"_e__J>olnter.

Header for new mail message

You fill out the mail header exactly as you did before. Because
this is an imaginary scenario, you send the message to yourself
instead of to a colleague.

Filling out a
mail header

~

Move the pointer into the document editor window.

~

Type in your own username in the To field. Press Return.
In the real world, you would enter the name of the real recipient.
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<> Type in the subject line as shown below.
Data for Project Saturn

The header should look like this:
Your own username should appear here

ISubject:

Data for Project Satunl,

Icc:
Alternate fields (name: value)
~======~I:

------------------------------,

~I

I

I: I

~======~

~I============================~

I
'-------------'1 : I~--------~~~~
[

Filling out a mail header

You can leave the rest of the fields blank.

<> Left click on OK to finish the header.
The dialog box disappears.
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DK

)]

(Cancel)

Entering
the message

To enter the message, move the pointer inside the document editor
and begin typing. The text will automatically appear beneath the
mail header.
<) Type in the message as it appears below:
Hi Jo, <RET>
I'm giving a presentation in a few days about how
Project Saturn stacks up against its competitors.
Do
you have any data that I might be able to use? <RET>
Thanks for helping me out. <RET>
--Your name
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When you are finished, it should look like this:
....
;=;:,::

Add

To:
Subject:
Cc:

Edit

File

Mail

Print

Document

Editor

smith
Data for Project Saturn

Hi Jo,
I'm giving a presentation in a few days about how Project Saturn stacks up
against its competitors. Do you have any data that I might be able to use?
Thanks for helping me out.
--Chris SmitlJL

From:
Date:
To:
Subject:
Cc:

"Chris Smith" <smith>
Wed, 16 May 90 14:36:01 EDT
smith
ou tIi n e for Pro j e c t Saturn pre sen ta ti 0 n

Sal-Project Saturn is really on a roll. I'm glvmg a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?

Typing in a mail message

When you are finished with the mail message, you can send it. .
Sending the
message

To send the message, you use the Mail-Send-Send Message
option on the menu bar.
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o Right hold on the Mail

menu. Highlight the Send option,
then the Send Message option. Release.

Editor

Hi Jo,
I'm giving a presentation in a few days about how Project Saturn stacks up
against its competitors. Do you have any data that I might be able to use?
Thanks for helping me out.
--Chris smitlJL

From:
Date:

To:
Su bject:
Cc:

"Chris Smith" (smith)
Wed, 16 May 90 14:36:01 EDT
smith
Outline for Project Saturn presentation

Sal-Project Saturn is really on a roll. I'm giVing a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?

Sending a message

BBN/Slate sends the message and deletes the buffer from the
screen. If BBN/Slate is unable to send the message, you will see
an error message giving you the reason.
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Saving your
message

Before going on to the next section, save the comments that you
made to the outline.

• Right hold on the File menu on the menu bar. Highlight
wri te, then drag right to highlight Same File. Release.

Receiving Mail
During this session, you have sent two messages. Under normal
working conditions, you would have sent these to other people.
Because you are working with imaginary people, however, you
sent these messages to yourself.
Now you'll take a look at these messages to see how you receive
mail from other people.
Depending on how fast your system is, you've probably already
received the first message that you sent earlier in this session.
Every so often, the document manager checks to see if you have
new mail. If you do, your system beeps, and BBN/Slate displays
a [New Mail] announcement at the top of the document
manager.
Look at your document manager to see if the announcement [New
Mail] appears, as it does in the next figure.
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New mail
announcement
~'!'I: :1,'r,t."1Rirn:llliiilCi"

1:
2:
3:

U
U

16 May 90
16 May 90
16 May 90

, ""I"

.a)' :I!*-'r"

smith
sm!th
smith

Introduction
Presenta ~ion
SalesReqlons

\

11~:Wl!l!~mln'·:";,,i'

"Iii,".

.L'.:
~

I1l%

1'fu

fl11Je':l\ttril\ll:l\'i[11~W!IW·!!gf.1d!l~'RltUi!\l1l'$!il·pnttAt:r,:::t!l¢lt!'lalli{1t!tt:\ill'M2al::UWIMj1!ttli!$$ .;1~

131

-,.:;~,~

~....
( show )

(compose) (

send

) ( cancel)

(forward)
( print
(

+(le~ting Started ~
...

:====;:;;.)

+Mallbox

(new ma I r)
( filter)

a+demo
m?At"$!Ii!Z;f!:ltt:ttli .,•.
:~

conf

'~'I

L,.·.,•••.·.;.'.'.,•.••

.......

sort

( select
(

( done

Folder: +Ne"!l..
(

next

(~f7o'";"ld"'e-r~)

) ( reply ) ( delete )

( save

)

New Mail announcement

If you see this announcement, you can look at the messages that
have just arrived"
To read mail, you use the new mail button
manager.

Reading
mail
<)

III

the document

Left click on the new mail button.
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1: U
2:
3: U
=~

( show)

16 May 90
16 May 90
16
90

smith
smith
smith
.lJ:'.f'>""";1'~;1r:

(compose) (

send

) ( cancel)

(forward)
( print
(

( done)

+uetting Started ~
+Mailbox
...
C ~ at1IiltX';;;;;;:l":i J
+demo

sort

( select
(

conf

(

next

) ( reply ) ( delete )

)

( save

)

here

Using the new mail button

BBN/Slate switches you to your mailbox and checks to see
whether you've received any new mail. If you have, the new mail
appears in the document editor, where you can read it. If you
haven't received any mail yet, you can read it later.
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From:
Date:
To:
Subject:
X-MMDelivered-For:
X-MMDelivered-By:

Glassi

Document

Editor

Chris Smith
<smith@BBN,COM>
Mon, 21 May 90 10:04:29 EDT
<smith@BBN,COM>
Outline for Project Saturn
presentation
smith
mmdeliver on spcink,bbn,com at
10: 14:22 OS/21/90

Cc:
Sal-Project Saturn is reaJly on a roll. 1'm gIVing a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?
Thanks-Chris Smith

Saturn: Up and Coming in a Growing Market
The most recent addition to our product line, Project Saturn is a software
e that runs on most workstations. Easy to learn and to use, Saturn

Reading new mail

At the same time, BBN/Slate displays the following dialog box.
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These users sent you multimedia mail and are not
on your list of default multimedia mail recipients.

;1 (

You may add them to your list by confirming this dialog.
smith

delete )

~

i
L -_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

((

OK

))

(undelete)

~~

(Cancel)

Adding users to list of multimedia mail recipients

Whenever someone sends you multimedia mail for the first time,
BBN/Slate asks whether to add the name of the sender to your list
of multimedia mail recipients.
Because you sent yourself a multimedia message, the name in the
dialog box is your username. Add yourself to the list by left
clicking on the OK button.

(\ Left click on the

OK

button.

Now read your mail. Use the icons in the vertical scroll bar to
move through the document if you need to.
After you finish reading one piece of mail, you can read the next
piece by using the next button.

<> Left click on the next button.
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( show)

(compose) (

send ) ( cancel)

( done)

(forward)

(new mail)

( print)

( filter)

(

+Getting Started
+Mailbox

~

+demo

sort)

( select)
( conf )

Folder: •
( reply ) ( delete )

( folder)

( save

)

Left click
here

Displaying the next message

If you have another piece of mail, it appears in the document
editor. BBN/Slate leaves the original message in the editor if you
do not.
Reading your
mail later

For various reason, you may read your mail later on in the tutorial
while you are working in another file. When you click on the
new mail button, your mail appears in the document editor and
the buffer you were working in disappears. After reading the
message, you can go back to your original buffer by using the
Edi tor menu on the menu bar.
To return to the buffer you were working in, right hold on the
Edi tor menu on the menu bar. Then drag down to highlight the
Buffer option and highlight the Switch To option. Highlight
the name of the original buffer and release.

Saving your
messages

You don't have to do anything to save your mail messages. When
you finish with BBN/Slate and exit the system, they will remain in
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your mailbox. If you like, you can delete them from the document
manager or move them to another folder as you did in Chapter 2.
Make sure that you really want to delete any messages before
using the delete button in the document manager.
After reading your mail, leave the messages in the editor and go
on to the next chapter. If you want to exit from BBN/Slate and
take a break, leave the system as described at the end of Chapter
2.

In this chapter, you've made good progress toward getting your
presentation prepared. You:

•

sent a document with comments attached to it
composed and sent a new mail message

•

read your mail

In the next chapter, you add spreadsheets and business graphs to
your presentation materials.
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5

Creat~ng

Spreadsheets and
Bush1ess Graphs
In your last session, you sent a mail message to a colleague in
Lisbon asking for financial information for your presentation. This
colleague has been experimenting with BBN/Slate as well and has
created a spreadsheet and bargraph for you from the data for
Project Saturn.
Assume that you've prepared a new document, called
Presentation, which follows the outline you created during
your first session and which contains the spreadsheet and bargraph
your colleague has sent you. During the company meeting, you
plan to use Presentation as a handout. Now you want to
change some values in the spreadsheet your colleague sent you and
also create another one.
During this session, you:
•

open a new file
edit a spreadsheet and regenerate a bargarph

Before you begin

•

create a new spreadsheet

•

refine the new spreadsheet

•

create a piech art from the new spreadsheet.

If you exited from BBN/Slate at the end of Chapter 4, re-enter the
software as shown at the beginning of Chapter 3.
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Opening a new file
At the end of the last chapter, you were in your Mailbox. Switch
to the folder +New and open the document called
Presentation, the document you will hand out during your
presentation.

<> Using the left mouse button, double-click on the folder name
+New.

<,

Double-click on the name Presentation.
Double-click
here

/

./J~

~\i'''h'''F.l~~il"1

1:

09 May 90
I •

3:
4:

L'ffi'ni..

I'

U

smith

.

:rH"

.

iP

'

smith
smith

>;.

",.,.":.,,,...:.>, ",
oj

Introduction

• I

09 May 90
10 May 90

,il.Ji!.I\/r<"Ii,!::\,:·

~~

."

-

•

...

T

>

SalesReglOns
Outline

...
T

( show )

(compose) (

send

) ( cancel )

( done )

(forward)

(new mail)

( print )
( sort )
( select )

( filter )

( conf )

+Getting Started
+Mailbox
+demo

T

Folder: +Ne"!l,.

( next

)(

reply

)(

delete)

( folder ) ( save )

Opening a new file

The new document appears in the document editor.
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i

Edit

Mail

File

Print

Document

Editor

Saturn: Up and Coming in a Growing Market
The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Project
Saturn is bound to become a bestseller.
Unlike many software packages, which are limited to one or two
machines, Project Saturn is available on most workstations. What's more,
the look and feel of Project Saturn is the same regardless of the machine
you use. Users on all workstations can learn the software quickly and
produce professional-quality documents immediately.
We expect high sales in Europe and in the United States. Because we
have little competition in Europe, we anticipate high sales during the
first year and increases of 30% and 60% during the second and third
years, respectively.
The spreadsheet and accompanying bargraph below highlight the current
sales projections for Saturn:

After opening a new file

Editing a spreadsheet
The spreadsheet in this document contains formulas that calculate
projected sales. You have just found out that one of these
calculations is incorrect.
Changing a value

The incorrect number is the expected number of sales in Great
Britain for Year 1, which is currently 4.60. You can find this
number in the fifth row of the second column.
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o Left click on

the number 4. 60.

A B C

D

i-d- .............................. S.p:L.E? .PFl()~E.S;:rI()f\JS..(i.r:..l1lil.lio.r:.~. ()f..$)..... .
2
3

~

..... _.. LREGION
Regio.n.1.......

YEAR 1
. .' .......... '4:~r....... .

~ ..... Clrf>":t..Bri.t"in..... r--~~"""'''''1
6

Ireland

16 Total

~ .................... .
~Regi?n3. ... .
19
Italy
:::::.P.or.tU.9.a.1
21
Spain
22 Total

~

YEAR 2

YEA

2,30

7.36
3.68

53.80

72.63

86,08

11.34
6.35
15.53
33.21

13.44
.................

4.70
11.50
24.60

Left click
here

. ................... .
6.21
3.10

8.40 ..... .
..........

,.-

7.52
18.40
39.36

~ ...... "....
.., ............................................ .
~ R.egron4 .....
. ............. .
~ . . [)enma.rk...
,., .... ?:?Cl ............ 7.43
.,., .... ~:EJCl ... .
~
,Fin.la.n~ .................. , ....... ?:?Cl ............ .!:?Cl."....
9.12
~ ...... [lJ0.r"',ax..
8.90
12.02
14.24
28
Sweden
10.20
13.77
16,32
29 Total
30.30
40,91
48.48

Selecting a cell

You have just clicked on cell B5. The cells in spreadsheets are
numbered by column (identified by letter) and row (identified by
number). Cell B5 is at the intersection of the second column (B)
and the fifth row (5).
Notice that cell B5 is highlighted, or surrounded by a gray box,
meaning that you can edit it. Edit the cell by typing in the new
number, which is 20.6.
~

Enter the number 20. 6 into the cell. Press Return.
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After you press Return, the next cell down (B6) becomes
highlighted. Notice that several of the numbers in the spreadsheet
(those in cells C5, D5, B7-D7, B31-D31) changed. These numbers
are based on formulas that depend on the value in B5. When you
changed the value in B5, these numbers were recalculated
automatically.
A

I

B

c

I

D

-4.............................. S.i\L.E~.?F1<?~E9:r!()I\J.S
..(i.':l .. I)!~I!i?':l.~.~fJL .. .
2
: :
3

REGION

YEAR 1

YEAR 2

YEAR 3

±~::~:~~~h:B:~i:t~i~::::::
:.:.:.:.:.:.:.:.:.:.:2.30
.g.9.:.~ ::::::::::y;:~:1
::::::::::)~:9.~
::::::::
6
Ireland
3.10
3.68
7

Total

22.90

30.92

36.64

I",gt~~~f~,;,JIIIJ~;lj~:li • • •
15
Switzerland
16 Total

7.20
53.80

9.72
72.63

11.52
86.08

i ""I~,f"9~,jii';ii'~~; • • • •
21
Spain
22 Total

11.50
24.60

15.53
33.21

18.40
39.36 ........

28
Sweden
29 Total

10.20
30.30

13.77
40.91

16.32
48.48 ........

I",gi~lrB:i!fi,~:!!j;! ••••
After editing a cell
Regenerating a
graph

Your colleague generated the bargraph attached to this spreadsheet
using the old values. Although the spreadsheet editor recalculates
the values inside the spreadsheet automatically when you change a
number, it does not automatically regenerate the attached bargraph.
Before regenerating the graph, scroll down a little so that you can
see the bottom of the spreadsheet and the graph at the same time.
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<> Left click on either set of arrows until the screen looks
something like this:
. I.

Add

Edit

File

I

I

I

Mail

I

Print

DQnmark
5.50
., ·············5:76
Finland
8.90
Norw,ay
3wQdQn
10.20
30.30
29 Total
30
31 Total for all rQ ions
107.00
32
33

Document

Keycaps

Editor

7.43
. ..
7.70
12.02
13.77

8.80
...............
.
9.12
14.24
...... 'i ;3:32

40.91

48.48

144.45

171.20

Exit

......

....

Sales Projections
By Year
Sales

o

200

Region

D

150

Region 2

o

100

Region 3

[ill]

50

Region 4

~

YEAR 1

YEAR 2

YEAR 3

Total

Year
~..

: :~)1i~A,tt);~t~>:,;;~;

I!t:~%i,7;::-dh;\:@ii1A§:1#~~4+%M~lq

Bu f f er: Pr esen ta tion * fil e: Prese n ta tiD n .sl t lliAAbd'%~;~+i;:tX:;:;;'/>:VMi>@<_;:<:1t.t#j I

Scrolling down

To regenerate the graph, you use the Graph-Generate option
on the Sheet menu.

<> Right hold inside the spreadsheet. Highlight the Graph option,
then the Generate option, then the Graph! option. Release.
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.BBN/Slate~Multi

Document

Editor

.. ···········7:43 ············iiEio ....... .
·············7:70 ············9:·1·2 ....... .

···········i2:02 ············i4:24 ..... .
................... .................... ..... .

Sales

o

200

Region 1
r:::l

150

t.:..8
Region 2

El

100

Region 3
Uillill

so

Region 4

~

YEAR 1

YEAR 2

YEAR 3

Total

Generating a graph

The graph changes to reflect the new projections.
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Sales Projections
By Year
Sales

o

200

Region 1

150

D

Region 2

o

100

Region 3

tJ]

50

Region 4

~

YEAR 1

YEAR 2
Year

YEAR 3

Total

After regenerating bargraph

Creating a spreadsheet
You decide to create another spreadsheet to show how much
revenue you expect Project Saturn to generate in the United States.
Left click on the arrows in the vertical scroll bar to move down
through the document. Place your cursor after the paragraph
ending "$67 million."

Adding a
spreadsheet

~

Left click after the paragraph ending "$67 million."
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Edit

File

Mail

El

100

Region 3

m

50

Region 4

~

YEAR 2
Year

YEAR 1

YEAR 3

Total

At home, Saturn has more competition. The competition is fiercer in
the Western and Midwestern regions than in the Mississippi and Eastern
Seaboard regions.

Market Share -- USA
In the first year, we expect to have a market share ranging from 12% in
the Midwest region to 43% in the Mississippi region. Total sales should
approach $67 million..ll..

remain competitive in our current European
ongholds and move forward in the Western
we will also continue to lead our market

Left click here

After positioning the cursor
~

Left hold on the Add menu on the menu bar. Drag down to
highlight the Spreadsheet option. Release.
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lliillll

Region 4

~

YEAR 1

YEAR 2
Year

YEAR 3

Total

Adding a spreadsheet

A blank spreadsheet appears after the paragraph. Notice that this
time you used the left mouse button to select a menu from the
menu bar. Use whichever button is more comfortable to you.
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~

Add

Edit

File

Mail

Print

Document

Editor

Market Share -- USA
In the first year, we expect to have a market share ranging from 12% in
the Midwest region to 43% in the Mississippi region, Total sales should
approach $67 million.
B

A

E

. .. .." ......
. ....... , ... ..
................ , ........................ , ..... .
~........

..... , .................. , ......................... , ....... .
........................ ,·......................... ., ..... .
·
.

,

........... , ......................... ,
·
.
.
....................... ,··.................................
.
.

......... "

.......... ,

.. ................. .
,

Key Project Goals
Project Saturn will help us remain competitive in our current European
and Eastern, United States strongholds and move forward in the Western

After adding a spreadsheet

In this spreadsheet, you'll show the total market, the expected
market share of Project Saturn, and the expected revenue. You
show these categories as labels along the top of the spreadsheet.
Labels are one of the three types of values you can use in
BBN/Slate spreadsheets. The other types of values are numbers
and formulas.

Entering labels

Begin the labels in the second column of the first row.
~

Press TAB to move to the second column.
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You have moved to cell Bl.

Notice that cell Bl is highlighted.

Moving to cell 81

<I Enter the following label into cell BI:
TOTAL MARKET

<> Press Tab.
The label is overflowing into the next cell. Don't worry about the
overflow now - you will enlarge the cells in a minute.
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...............................................................
·
.; .................. .
..........................................
....................; ........................................ .
.................... i .................... i .................. .
··
..
...............................................................
...............................................................
....................;··....................;.................... .
·
.
~

E

F

...................................................... .

)

;

Entering a label

~

Enter the following labels:
MARKET SHARE <TAB>
EXPECTED REVENUE

~

Press Return.
When you are finished, the labels will run into each other as
following figure:

III

the
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Spreadsheet with overflowing labels

To enlarge the cells, you drag on the column boundaries using the
middle mouse button.

Enlarging cells

o

Select the spreadsheet by left clicking on it.

¢'

Middle hold on the right boundary between the "B" and "C"
labels.

o Drag the boundary

right until you have enough room for all of
the first label. Release.
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I

Middle hold here and drag right
F
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··
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.
.
.
;

;.

;
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Extending column boundaries

If you move the boundary too far to the right, you can move it
back again. Extend the boundaries of column C and D in the
same way.
¢ Middle hold on the right boundary of the cell containing "C."

Drag right until you have enough room for the label. Release.
~

Middle hold on the right boundary of the cell containing "D."
Drag right until you have enough room for the label. Release.
The labels should now look something like the ones in the next
figure.
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After extending column boundaries

You can now continue to fill in the spreadsheet. First finish the
labels on the top.

o Left click in

cell B2. Enter the following label:

(in millions of $)

<> Press Tab.
The spreadsheet should look like the following one:
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~
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Adding the second row of a label

Complete the other two labels in the same way.
~

Enter the following labels:
(Percentage) <TAB>
(in millions of $)

~

Press Return.
When you are finished, the labels should look like the ones in the
following figure.
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After completing the second row of labels

Whenever you finish entering a value into a cell, be sure to press
Tab or Return. Tab moves you to the next cell in the same row,
and Return takes you to the next cell in the same column. If you
left click on another cell before pressing Tab or Return, you will
change the value of the current cell.
Now fill in the side labels.
t')

Left click on cell A3. Enter the following label:
Western

<> Press Return.
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Adding a side label

Add the other side labels as shown in the next figure.
,) Enter the following labels:
Midwestern <RET>
Central <RET>
E. Seaboard <RET>
TOTAL
<)

Press Return.
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MARKET SHARE

D

E

;EXPECTED REVENUE

::::::::.:::::::: ::((~: :~:(Iifo:~~: :~:f: ~i::: kp~~~~:~:t~g:~):::::::: ;(i; n:: ~il:l:i?n:~: :of:h:::::::

Western

After adding side labels

If you make a mistake, you can correct it by editing the contents
of the cell.

Correcting
mistakes

First select the cell by left clicking on it. Then, left click after the
letter or number you want to edit, and press the Delete key to
delete the incorrect letters or numbers. Finally, type in the new
letters or numbers and press Return.
You can now begin entering the numerical data of the spreadsheet.
Begin in cell B3 and work your way down columns Band C.

Entering numbers

<)

Left click on cell B3. Enter the following numbers:
100 <RET>
63 <RET>
49 <RET>
85

~

Press Return.
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Entering numerical data in column B

When you get to the end of column B, be sure to press Return
after the last cell. Then move to the top of column C and enter
the data for that column.
¢ Left click on cell C3. Enter the following numbers .
. 21 <RET>
.12 <RET>
.43 <RET>
.35
~

Press Return.
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Entering numerical data in column C

The values in column D are calculations based on columns Band
c. You calculate these values using formulas.

Entering formulas

First calculate the value of cell D3, then copy this formula into the
rest of column D.

<,

Left click in cell D3. Enter an equals sign:

< Left click in

cell B3.

When you click in the cell, a reference to it appears in cell D3.
As an alternative to clicking on cells, you can also type in the cell
references in either upper- or lowercase.
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Entering cell references

t Enter an asterisk:
*
¢; Left click in cell C3.
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Adding a formula
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The formula begins with an equals sign
spreadsheet to interpret the cell contents
spreadsheet editor interprets the formula
of cell B3 multiplied by the contents of

(=), which tells the
as a calculation. The
=B3*C3 as "the contents
cell C3."

$ Press Return.
After you press Return, the spreadsheet editor calculates the value
from the formula and puts the value into the cell.
B C D
:TOT AL MARKET ,MARKET SHARE ,EXPECTED REVENUE,
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After calculating a formula

You can use the formula you have already entered in cell D3 as a
basis for the formulas in the rest of column D. You just highlight
the cell containing the formula (in this case, D3) and drag down to
highlight all the cells in column D. Then select the Fill Down
option from the Edit menu.
~

Left hold on cell D3. Drag down to highlight cells D4 through
D6. Release.
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Highlighting multiple cells

If you highlight too many cells, middle click to deselect the
region, and then begin again. Notice that the first cell you
highlighted, cell D3, still has the gray box around it. The other
cells are highlighted in black.
~

Right hold inside the spreadsheet to display the Sheet menu.
Highlight the Edit option, then highlight the Fill Down
option. Release.
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Duplicating a formula in a column

Values appear

In

cells D3 through D6.
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Values calculated after duplicating a formula

There is one more value to calculate to complete this spreadsheet.
Cell D7 is the total of cells D3 through D6. You calculate this
number using a formula.
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~

Left click on cell D7. Enter the following formula.
=SUM(03:06)

The spreadsheet editor interprets this formula as "the sum of the
values in cells D3 through D6." When you separate two values
with a colon, as you did with D3 and D6, the spreadsheet editor
calculates the values from those cells and all the cells in between.
As a short cut, you could have clicked on cell D3 and dragged to
cell D6 to enter the reference D3:D6.
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Entering a formula

Press Return to calculate the value.
~

Press Return.
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After calculating the value

Refining the spreadsheet
After calculating the total expected revenue, you are finished with
the content of the spreadsheet. Now refine it by resizing it and by
adding lines, called rulings, to define the spreadsheet.
Resizing the
spreadsheet

Your spreadsheet takes up less cells than the spreadsheet editor
displays. You want to make it smaller, which you do by dragging
the handles at the edges of the spreadsheet. The following figure
shows the handles on the right side of the spreadsheet.
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Handles

Spreadsheet handles

Resize the spreadsheet by left holding on the bottom right handle
and dragging it.
~ Left hold on the bottom right handle.
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Left hold h e r e /

<> Drag up and to the left until the spreadsheet is about the size
of the one in the following figure.
When you drag on the handle, the cursor changes to a pointing
hand:
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Dragging a spreadsheet handle
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When you are finished, the spreadsheet should look like this:
1

A B C
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After resizing spreadsheet

Even though the spreadsheet looks smaller, you can still add data
to the spreadsheet until it reaches its maximum size of 2048 rows
by 256 columns.
Adding rulings

When you left click outside the spreadsheet, you no longer see the
grid and row and column numbers that you saw while editing it.
To outline the rows and columns, you can add your own lines, or
rulings, using the spreadsheet editor. These rulings appear both on
your workstation screen and on paper.
To add rulings, you select the area you want to outline, select the
type of outline you want, and apply it.
First put a boxed ruling around the main part of the spreadsheet.
~ Left drag from cell A3 to D7.

~ Right hold inside the spreadsheet. Highlight the Rulings

option. Release.

Creating Spreadsheets and Business Graphs 5-31

r'--'-----~----~_....__I Font ...

Column Width ...
Graph
=:>
File
=:>

Selecting a region

The following dialog box appears.
Ruling Style

[I] D
((

-

I::::: C]
OK

~

111111
.
,......

r"""on
o
@Add
Clear

( Can Gel )

(Keep Up)

Rulings window

You want to keep the dialog box up while you work.
<)

Left click on the Keep Up button.

Ruling Style - - - ,

[I]

D

-

111111

C r::::

c] :. . :

K

)]

OK

Operation
@Add
Clear

o

(CanGel)

Keeping the ruling style dialog box up
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Left click
here

The dialog box moves outside the document editor window, out of
your way.
To surround the region you have highlighted with a box, use the
box ruling style.

• Left click on the box ruling style.
• Left click on the Add button.
• Left click on the Apply button.
Left click here first

Left click
here second

~-~~-~
_111111
:.... : [::! LJ ......
(Take Down)

Left click here last

Adding a ruling

After you click on the Apply button, the spreadsheet editor
applies the selected ruling to the highlighted area, as shown in the
following figure. To see the rulings, deselect the spreadsheet by
clicking outside the spreadsheet but still within the document
editor.

• Left click in another part of the document editor to see the
ruling.
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TOT AL MARKET
_(in millions of $)
Western
Midwestern
Central
E. Seaboard
TOTAL

MARKET SHARE
(Percentage)

100
63
49
85

EXPECTED REVENUE
(in millions of $1

0.21
0.12
0.43
0.35

21
7.56
21.07
29.75
79.38

After adding ruling

Now define the columns using the same square ruling style.

<> Left click on the spreadsheet to select it.
<> Left drag from cell Bl to cell B6.

Selecting a column

Now apply the ruling. Because the square ruling style and Add
operation are already selected, you only need to click on the
Apply button.
¢'

Left click on the Apply button.
When you left click outside the spreadsheet, it should look like
this:
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100
63
49
85

Western
Midwestern
Central
E. Seaboard
TOTAL

EXPECTED REVENUE
(in millions of $)

MARKET SHARE
Percentage)

TOT AL MARKET
in millions of $)

21
7.56
21.07
29.75
79.38

0.21
0.12
0.43
0.35

After applying ruling to column

Apply the same ruling style to columns C and D.
¢ Left drag from cell Cl to C6.
~

Left click on the Apply button.

~

Left drag from cell Dl to D6.

¢ Left click on the Apply button.

When you are finished, left click outside the spreadsheet. It
should look like the one in the next figure:
TOT AL MARKET
in millions of $)
Western
Midwestern
Central
E. Seaboard
TOTAL

MARKET SHARE
Percentage)

100
63
49
85

0.21
0.12
0.43
0.35

EXPECTED REVENUE
in millions of $)

21
7.56
21.07
29.75
79.38

After adding rulings to columns

You need to add one more ruling to make the spreadsheet
complete.
~

Left click on cell A6.
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A

c

8

4- 1}/E!5.te.rn......
4

~ ¢:~:~~:r.~L:::.::.::·::·:::::::...

-47

0.21
21
...............................................

100
63

Midwestern

o

0.12

7.56

49............
0.43
21.07
5
~:.§~~~.~!.9-'<--_ _ _ _ _8'--5--'-_ _ _--=-0_.3-"-5'--_ _ _---'2=-=9:-':.7:-::-1
TOTAL
79.38

~.

:

9 :

:

)

:

Selecting a cell

Now choose the underscore ruling style.

<> Left click on the underscore ruling style.
~ Left click on the Apply button.
Left click
here first

Operation
111111

@Add

o Clear
(Take Down)

Left click here last

Applying an underscore ruling

When you left click outside the spreadsheet area, your spreadsheet
should look like this:
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Western
Midwestern
Central
E. Seaboard
TOTAL

TOT AL MARKET MARKET SHARE EXPECTED REVENUE
in millions of $)
in millions of $)
Percentage)
21
0.21
100
0.12
7.56
63
0.43
21.07
49
0.35
29.75
85
79.38

Spreadsheet complete with rulings
Correcting
mistakes

If your spreadsheet doesn't look quite as it should, you can remove
rulings the same way that you added them.
For instance, if you had an underscore ruling in cell B3, you could
remove it using the Clear button in the rulings dialog box.

/
Western
Midwestern
Central
E. Seaboard
TOTAL

/

Incorrect ruling

TOTAL M;%;T MARKET SHARE EXPECTED REVENUE
in millions f $)
Percentaqe)
in millions of $)
100
0.21
21
63
0.12
7.56
49
0.43
21.07
85
0.35
29.75
79.38

,.

Incorrect ruling

To clear the incorrect ruling, first left click on cell B3. Next, left
click on the underscore ruling in the dialog box. Then, left click
on the Clear button and on the Apply button in the dialog box.
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Left click here first

Left click
here
second

111111

(Take Down)

Left click here last

Removing rulings

When you click outside the spreadsheet, the ruling will be gone.
Taking down the
rulings dialog box

You are finished with the rulings dialog box, so you can take it
down.

<> Left click on the

Take Down button on the Spreadsheet

Rulings dialog box.
I

..

I

....

Ruling Style

I!ll

D

-

--~

111111

D [: :::1 ...

Operation
Add
@ Glear

o

[ APPly))

Taking down the rulings dialog box

The dialog box disappears.
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Left click
here

Spreadsheets, by default, appear with outlines when you left click
outside them. To have the spreadsheet appear without the outline,
use the Change Attributes option on the Edit menu.

Removing the
outline

<)

Left click on the spreadsheet to select it.
1

A B C
TOTAL MARKET MARKET SHARE

'(ri'rili'liio'ris" adj"

2

D
EXPECTED REVENUE

.. 'Percen'ta ge'i' ....... in' mill'iorls ·odi)· .. · ..

~ VV0s.te.':n............................ 1.0.0.....................0:;2.1 ............................2.1 ..

4- rvild.¥iest"rl'l.

+ ~:e~~~~'o'a'~d"
7

.......................6.3....

.. ...0:.1;2 ....................... .7.'.56

."6':~~ ..................... ~·~X~

..................... ·:·~I..

TOTAL

79.38

.:

~
9

Selecting the spreadsheet

Now select the Change Attributes option.

<> Right hold on the Edit menu on the menu bar. Highlight
Change Attributes. Release.

""';,

Mail

1~~-7~~~.m~~--~~

Print

Document

Editor

a market share ranging from 12% in
e Mississippi region. Total sales should

... .

~

.......................... ........................... .
~

Changing attributes

When the dialog box appears, click on the cycle button beside
Outline. Then click on OK.
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~

Left click on the cycle button beside Outline.

~

Left click on OK.
Outline
Justification
Break Page
Keep with Next
Printed Size

C
C
C
C

None
None
No
As On Screen

Left click here first

( Cancel)

Left click here last

Selecting no outline

When you left click outside the spreadsheet, it should look like
this:
TOT AL MARKET
in millions of $)
Western
Midwestern
Central
E. Seaboard
TOTAL

MARKET SHARE
Percentaqe)

100
63
49
85

0.21
0.12
0.43
0.35

EXPECTED REVENUE
in millions of $t

21
7.56
21.07
29.75
79.38

Spreadsheet without outline

Creating a piechart
Spreadsheets present information in rows and columns. Sometimes
analyzing data is easier if you can translate these rows and
columns into graphs.
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You can create bargraphs, piech arts, and line graphs from
spreadsheets. Since piecharts are good for showing percentages,
you decide to make a piechart showing the percentage of revenue
contributed by each region.
Creating a graph

To make a piechart, you select the Graph-Create option on the
Sheet menu and fill in the information that BBN/Slate needs to
create the graph.

<> Right hold inside the spreadsheet. Highlight the Graph option,
then highlight the Create option. Release.
A

Sheet

C

D

T SHARE

: i'ta~8'i'"

EXPECTED REVENUE

.in' niiilions"of":ji)'

21
...........0.21
, ........................... , ......... .
0.12
7.56
..................................................

=> ...........0 . ~3

21.07
29.75
79.38

0.35

9

File

G(-)f\orato

'o:mmmmmmmmmmmmm,q Modify
DelH1:()

Fn!!uw

enw.k. Link

=>5-----~~

=>
=>
=>
=>

Creating a graph

The following dialog box appears.
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IName:

graph 1..

Type @ Line
Bar
Pie

I

Ei Regenerate

AutomatiGally

Title

I

I

Line 1:
Line 2:

o
o

Axis Labels
IX:

IIV:

I

Values to Plot
IXRange: A:A

I

Dataset 01

Ei Display
Ei Display

Range: B:B
Labels:
Legend:

lines
Symbols

Grid 0 Both
X Axis Control
Min:
Max:
InGrement:

~

OK

))

V Axis Control
Min:
Max:
InGrement:

( CanGel )

Dialog box for creating graphs

BBN/Slate uses the values you enter here to make the graph from
your spreadsheet. Begin by defining the graph as a piech art and
giving it a title.

Defining the
graph type and
title

¢ Left click on the button beside Pie.
~

Left click in the Line 1 field. Enter the following:
Percentage of Revenue <RET>

By Region
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The dialog box should look like this:
Left click here
Enter the title here

/
Nam;:

/

A

graphl

T~o
I

Title

Line
Bar
Pie

Regenerate Automatically

..L

Line 1: Percentage of Revenue
Line 2: By Region

Axis Labels
IX:

IIV:

I

Values to Plot
IXRange: A:A

I

Dataset 0'1

&if Display
&if Display

Range: B:B
Labels:
Legend:

lines
Symbols

Grid 0' Both
X Axis Control
Min:
Max:
Increment:

((

OK

))

V Axis Control
Min:
Max:
Increment:

( Cancel)

Entering graph type and title

Continue to define the graph by telling BBN/Slate which values to
use for the piechart. Since you are showing the percentage of
revenue by region, you graph columns A (region) and D (revenue)
as the XRange. First, delete the default XRange of A: A.

Defining values
to graph

~

Left click after A: A in the XRange field.

~

Press the Backspace key three times to delete A: A.
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Left click here and
delete A:A

Name:

graph1

r'

Type -

o Line
o Bar

bi Regenerate

AutomatiGally

Li e 1: PerGentage of Revenue
Li e 2: By Region

@Pie

Axis Labels
X:

Iv:

I

Values to Plot
IXRange: A:AJ..

Dataset 01

Range: B:B
Labels:
Legend:

bi Display
bi Display

lines
Symbols

Grid 0Both
X Axis Control
Min:
Max:
InGrement:

~

))

OK

V Axis Control
Min:
Max:
InGrement:

( Can Gel )

Deleting the existing XRange

In a piechart, BBN/Slate uses the XRange to define the slices of
the pie. You want the four portions to reflect the four regions, so
you define the XRange as A3:A6. (Remember that cells A3
through A6 contain the labels Western, Midwestern, Central, and
E. Seaboard.)
~

Enter the following:
A3:A6 <RET>

The cursor moves to the next field.
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IName:

graph1

Type Line
Bar
@Pie

I

&f Regenera te

Automa tic ally

Title
Line 1: Percentage of Revenue
Line 2: By Revenue

I

o
o

Axis Labels
IX:

IIV:

I

Values to Plot
IXRange: A3:AI}.

I

Dataset 0'1

Range: B:B~
Labels:
Legend:

&f Display
&f Display

lines
Symbols

Grid 0' Both

V Axis Control

X Axis Control
Min:
Max:
Increment:

[(

OK

))

Min:
Max:
Increment:

( Cancel)

Moving to the next field

You have moved into the Range field. BBN/Slate uses the data
in the Range field to calculate the proportions of the pie. You
want to base the proportions on actual revenue as shown in cells
D3 through D6.

<> Press the Backspace key three times to delete B:B.
¢ Enter the following:
03:06
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IName:

I

graph1

I

Type Line
Bar
@Pie

(;;if Regenerate Automatically

Title
Line 1: Percentage of Revenue
Line 2: By Revenue

o
o

Axis Labels
IX:

IIV:

I

Values to Plot
I XRange: A3:A6

I

Range: D3:DE}..
Labels:
Legend:

Dataset ()1

(;;if Display lines
(;;if Display Symbols

Grid () Both
X Axis Control
Min:
Max:
Increment:

~

OK

~

Y Axis Control
Min:
Max:
Increment:

( Cancel)

Entering the Range values

This is all the information BBN/Slate needs to generate the
piechart.

o Left click on the OK

button.

When you select OK, BBN/Slate generates the piech art and places
it below your spreadsheet. It should look like the one in the
following figure:
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.
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~

~

Percentage of Revenue
By Region
Midwestern

Spreadsheet and piechart

The piech art you have created is linked to the spreadsheet until
you explicitly break the link between them. When you break the
link, you can no longer alter the graph from the Sheet menu.
The piechart is a graphic that you can edit using the BBN/Slate
graphics editor, explained in the next chapter. If you make any
changes to the piechart, these changes are not reflected in the
spreadsheet.
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Saving your
document

Save your presentation so that you'll be ready to work in the next
chapter. In addition to saving by selecting options from the menu
bar, you can also use the keyboard.

V Hold down the Control key.

o Press X,

then S.

BBN/Slate saves your document. For more information on using
other keyboard shortcuts, see the Customizing Manual.
If you want to exit BBN/Slate and rest before going on to the next
chapter, follow the instructions at the end of Chapter 2.

What you've learned
In this chapter, you have:

•

changed a value in a spreadsheet

•

regenerated a bargraph

•

created and refined a spreadsheet

•

created a piechart based on a spreadsheet

As well as learning specifically about spreadsheets, you are also
becoming acquainted with BBN/Slate's multimedia format. This
format lets you move to and from the media types most
appropriate to the information you want to convey.
In this next chapter, you add graphics and images to your
presentation.
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6

Creat~ng

Graphics and

~mages
Your presentation materials are coming along nicely. You have
good-looking text that will work well as a handout, and you have
a couple of spreadsheets and business graphs that reflect how
Project Saturn stands up to the competition.
You have found an image that will work well as a logo for the
project - a scanned image of Saturn. In this chapter, you add
this to the presentation materials.
You'll also add to the materials a map that one of your colleagues
sent you through multimedia mail. This map shows the expected
sales of Project Saturn in the United States. After adding the map,
you edit it by adding a key that names each region.
During this session, you work with images and graphics. An
image is a black and white representation of a photograph,
drawing, or screen display. You can import images from the file
system, capture them from your workstation screen, or create them
yourself using the BBN/Slate image editor.
Graphics are drawings composed of lines, geometric figures, text,
and textures. You can also include images within graphics.
How are images and graphics different? When creating graphics,
you can edit objects (such as text, lines, or shapes) separately. By
contrast, you work with an image as a single unit. For instance, if
you add a line to an image, it becomes an integral part of the
image. You can edit the line only by also editing the part of the
image surrounding it.
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In this session, you:
•

add an image from the file system
add a graphic from another BBN/Slate document
edit the graphic

Make sure that the document Presentation still appears in the
document editor. If you took a break after the last chapter and
exited the software, re-enter before beginning this chapter. Then
open the +New folder and the Presentation document.

Before you begin

You can import into a BBN/Slate document images that exist in
your file system. You may have scanned these images in yourself,
or you may have received them from other people or created them
in other software packages.
The image of Saturn is in the +Getting Started folder. You
can move to this folder without disturbing the document currently
in the document editor by double-clicking on its name in the folder
list.

Adding the
image

(>

Using the left mouse button, double-click on the folder name
+Getting Started.

Your presentation is still in the document editor, but your current
folder is +Getting Started. Notice that the document listing
doesn't contain anything named Saturn. This is because the list
contains only BBN/Slate documents, and the image you are adding
is not yet in BBN/Slate format.
Before you add the image, decide where to place it in the
Presentation document and place the cursor there.
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<> Move to the beginning of the document. Left click at the
beginning of the first paragraph.
To add the image, you use the Image-BBN / Slate Bitmap
option on the Add menu.

\/' Right hold on the Add menu on the menu bar. Highlight the
Image option. Highlight the BBN/Slate Bitmap option.
Release.

Mail

Print

Document

Editor

in a Growing Market
line, Project Saturn is a software
Easy to learn and to use, Project

~~~~~~~!ch are limited to one or two

Saturn is av .
on most workstations. What's more,
the look and el of Project Saturn is the same regardless of the machine
you use. Users on all workstations can learn the software quickly and
produce prof essional-quali ty documents immediately.
We expect high sales in Europe and in the United States. Because we
have little competition in Europe, we anticipate high sales during the
first year and increases of 30% and 60% during the second and third
years, respectively.
The spreadsheet and accompanying bargraph below highlight the current
sales projections for Saturn:

Adding an image from a file
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A dialog box appears. You enter the name of the file containing
the image, which in this case is Saturn. bi t.
¢ Type Saturn. bi t in the dialog box.

Left click on OK.

Image from file:

ISa turn .bilj.
(

List

( Cancel

J

Specifying the file containing the image

The Saturn image appears at the beginning of your document.
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Add

Edit

File

Mail

Document

Print

Editor

Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Project
Saturn is bound to become a bestseller.
Unlike many software packages, which are limited to one or two
machines, Project Saturn is available on most workstations. What's more,
the look and feel of Project Saturn is the same regardless of the machine
you use. Users on all workstations can learn the software quickly and
produce professional-quality documents immediately.

Document with image added from file
Changing
image
attributes

To center the image between the margins and remove the border
from the outside, you select the Change Attributes option
from the Edit menu.
Before changing the attributes, make sure the image is selected.
You can tell if an image is selected because of the handles that
appear around the outside. If you don't see these handles, left
click on the image to select it.
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Handles

~--------------------------------~

/

Handles on an image

<> Right hold on the Edit menu on the menu bar. Drag down
to highlight the Change Attributes option. Release.

Mail

Ir-------~~~~--------_,

Print

Document

Editor

ng in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Project
Saturn is bound to become a bestseller.

Changing image attributes
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You see a dialog box that lets you change the way the image
looks on your screen or on the printed page. To change the outline
and the justification of the image, you use the cycle button beside
the words Outline and Justification.

<> Left click on the cycle button beside Outline.
<> Left click twice on the cycle button beside Justification.
~

Left click on OK.
Left click here

Left click here
twice
Outline
Justifica tion
..... enter
Break Page
C None
Keep with Next C No
Float
C Don't Float
Printed Size
C As On Screen
Classification
C <none>
[

OK

]

(cancel)

Changing the image outline and justification

When you clicked on the cycle buttons, you changed the attributes
of the image. As you probably noticed when you clicked on the
Justification switch, this attribute has several possible values.
After you click on OK, the image moves to the middle of the
screen. If you click outside the image, the box around Saturn
disappears.
~

Left click outside the image area.
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I

I

• I

Add

Edit

File

Mail

Print

Document

Editor

Keycaps

Exit

Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Project
Saturn is bound to become a bestseller.ll..
Unlike many software packages, which are limited to one or two
machines, Project Saturn is available on most workstations. What's more,
the look and feel of Project Saturn is the same regardless of the machine
you use. Users on all workstations can learn the software quickly and
produce professional-quality documents immediately.

Image after changing attributes

Adding a graphic from a BBN/Slate document
In addition to adding images from the file system, you can paste
images, or in this case graphics, from other BBN/Slate documents.
One of your colleagues has sent you a mail message containing a
map that shows sales areas in the United States. When you
received this map, you stored it in a separate file. You decide to
copy this graphic from the file and paste it into your presentation.
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To copy this map, you open up the file, copy the graphic, and
paste it into your presentation.
Open the document containing the map and show it in the
document editor.

Opening two
documents at
once
<)

Double-click on the name +New.

<> Left click once on the name SalesRegions.

o Right

hold on the show button. Highlight the Show
Document with Previous Document option. Release.

Show Document
;·:·r:¥Wnw.~:1) fh1.t"f§DHi3i!lIt§"@W!iJlk;W[·liFt4·1.tH'lritAil~ Getting Started ....
(forward' Insert Document
Mailbox
~
( print )

( filter)

~

+demo

( wn )

y

( select)
conf)

Folder: +Getting Starte<1.
(h,ext

\

) ( reply ) ( delete )

( folder)

(~-s-av-e----)

Right hold here

Opening two documents at once

When you open multiple files, BBN/Slate keeps them in separate
buffers. Picture the buffers in layers in the document editor, with
the document you most recently opened on top. You can see only
the buffer on top.
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BBN/Slate displays the map in the document editor. Your
Presentation file is still in the editor, but in a layer beneath
the SalesRegions buffer.

~

Add

Edit

File

Mail

Print

DOGument

Editor

..........

File containing graphic
Copying a
graphic

To get the graphic from the first file into your presentation, you
copy it, go back to the presentation file, and paste it.

<> Left click inside the graphic to select it.
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Graphics, like images and spreadsheets, have handles. When you
have selected a graphic, you can see its handles around the outside
border.
Graphic handles

::::::::::r:--:--~-:-.,...,.";"",,,,:

··········j----'-'--'-''-.ll

Selected graphic with handles

After you select the graphic, you copy it by selecting Copy from
the Edit menu on the menu bar.

• Right hold on the Edit menu. Highlight the Copy option.
Release.
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.-:-:--:

;';';"

Add

File

Mail

Print

Document

Editor

Paste
Change Attributes ...

Copying a selected graphic
Pasting a graphic

Now that you've copied the graphic, you need to move to the
Presentation file. Because you already have this file open,
you simply move between buffers.
(>

6-12

Right hold on the Editor menu. Highlight the Buffer
option, then highlight the Switch To option. Select
Presentation. Release.
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File

Mail

Print

Document

...
Switching to another file

The Presentation buffer now moves to the front of the
document editor, and the SalesRegions buffer moves further
back. You want to place the map of sales regions at the end of the
paragraph ending "Eastern Seaboard regions." First move there
using the vertical scroll bar .

• Left click after the paragraph ending "Eastern Seaboard
regions. "
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Add

Edit

File

Mail

Print

Document

Editor

Sales

o

200

Region
150

[J
Region 2

El

100

Region 3

ITilll
Region 4

50

~

YEAR 1

YEAR 2
Year

YEAR 3

Total

At home, Saturn has more competition. The competition is fiercer in
the Western and Midwestern regions than in the Mississippi and Eastern
Seaboard regio

expect to have a market share ranging from 12% in
43% in the Mississippi region. Total sales should

Left click here

Moving to the end of the document

Now paste the map by selecting Paste from the Edit menu on
the menu bar.
(>

Right hold on the Edit menu. Drag down to select Paste.
Release.
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Document

Editor

o

200

Region 1

D"

150

','

Region 2

[J

100

Region 3

ill£]

50

Region 4

~

YEAR 1

YEAR 2
Year

YEAR 3

Total

At home, Saturn has more competition, The competition is fiercer in
the Western and Midwestern regions than in the Mississippi and Eastern
Seaboard regions...

Market Share -- USA
In the first year, we expect to have a market share ranging from 12% in
the Midwest region to 43% in the MisSissippi region, Total sales should
approach $67 million.

Pasting into a file

The map now appears in your presentation.

Editing a graphic
The map of the United States that you just pasted into your
document needs a key and a title. You can add them easily using
the graphics editor.
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Before you begin, resize the graphic so that it fits easily between
your margins. Then create the key by drawing and filling
rectangles that correspond to the sales regions on the map and
adding explanatory labels. Finally, add a title to the entire graphic.
To resize a graphic, you use the Edit-Scale option on the
Graphics menu.

Resizing a
graphic

<> Left click on the map to select it.
<)

Right hold to display the Graphics menu. Highlight the
Scale option. Release.
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!~0

Add

Edit

File

Mail

Print

Document

Editor

K

•

Group
Ungroup
Select All
Undn
Reshape
Move
Select

nnond Cnl'nel's
Smooth or Unsmooth

Selecting the entire graphic

A dialog box appears. Scale the figure to 60% of its original SIze.
<) Left click on the Size Only button.
~

Type in .6 in the scale factor field:
.6 <RETURN>
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Type in .6 here

Left click here

SGale faGtor:

[

OK

)]

.fi

(CanGel)

Scaling a graphic

In many dialog boxes, pressing Return is the same as clicking on
the OK button. After you press Return, BBN/Slate resizes the map
and leaves the border the same size.
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After resizing the graphic

You can resize the border by dragging on a corner handle. First
use the scroll bar to move down and to the right until you see the
bottom corner handle, as in the following figure.
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Mail

Print

DOGument

Editor

•

Moving to the bottom corner

Now drag the handle up and to the left. Leave some room
underneath the map so that you can add the key at the bottom .

• Left hold on the bottom right handle.
~

Drag up and left until the graphic looks like the one in the
following figure.
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Mail

Print

Document

Editor

•

Resizing the graphics border

After resizing the border, move up and to the left until you see the
entire map in the document editor.
To draw a rectangle, you use the rectangle tool on the graphics
palette. Bring up the graphics palette by selecting Palette
from the Graphics menu.

Drawing an
object

~

Right hold inside the graphic. Highlight Palette. Release.
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..

•

•

Preferences

~

Group
Ungroup
Select All
Undo
Reshape
Move
Select

Selecting the graphics palette

The graphics palette appears overlaid on the graphic.
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0

Add:

Fill:

[S][g

GJODOO[]!illilll

[Q]§]
~~
§][Q]

[ill ~~Hhll ~ UJ ~!illl

D]rcsJ

~ • • IIII!I!llI~~
[ill~[fIl~UJ~!illl
m1~~

~~
~
( Cancel)

~ • • 111.~~

m1~~

Pen:

l1

GJOmOO[]!illilll

Line:

B

1-1-1-1-1
(Keep Up)

The graphics palette

You want to keep the palette up while you work, so you click on
the Keep Up button.

t Left click on the Keep Up button.
The palette moves out of your way. To draw, you select items
from the palette and then use them within the graphics box.
Start the key by creating a rectangle.
~

Left click on the rectangle icon on the graphics palette.
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Add:

(Take Down)

Selecting the rectangle icon

The icon dims to show that you can draw a rectangle within the
graphics region. When you move into the graphics region, the
cursor changes to a pencil.
~

6-24

Left hold inside the graphics region. Drag right and down
until you create a rectangle about the size of the one in the
next figure. Release.
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Drawing a rectangle

Notice that the graphics editor automatically lines the rectangle up
with the dotted lines on the background of the graphic, called the
graphics grid. With grid mode turned on, you can easily create
and place the rectangle accurately. To have more control over
where you place objects, you can turn grid mode off.
Because the map contains four regions, you create four rectangles
for the key. Instead of drawing four separate boxes, you use the
Duplicate option on the Graphics-Edit menu.

Duplicating an
object

¢ Left click on the rectangle to select it.
~

Right hold anywhere inside the graphic to display the
Graphics menu. Highlight Edit, and then drag right to
highlight Duplicate. Release.
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Palette ...
Style
Placement
Preferences
Group
Unuroup
Select All
Undo
Reshape
Move
Select

'¢
'¢

Cut
Paste
Copy
Clear

WT1'i1 mmijm:i;';;;;Z:=
Scale ...
GhHn~.l(-) Arrow~

Round Corners
'¢
Smooth or Unsmnn t h &-:--'--'----'--'--:""""':---'---=-""':"'-'-4

Duplicating the rectangle

The duplicated rectangle appears on top of the original rectangle.
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Duplicated rectangle

Create the other two rectangles in the same way.
~

Left click on either rectangle to select it.

• Right hold inside the graphic. Highlight Edit, and then
highlight Duplicate. Release.
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Gruup
Unnruup
Select All
Undo
Reshape
Move
Select

Gh<U\~.l() Arrow,:;
Round Corners
Smooth ur Unsrnootb

'*

Duplicating the rectangle again

To create the final rectangle, select the Duplicate option once
more.
~

Right hold inside the graphic. Highlight Edit, and then
highlight Duplicate. Release.
You have created four rectangles.
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..
. .
.

~

.

Duplicated rectangles
Positioning
objects

After creating the four rectangles that will make up the map key,
you position them. With grid mode turned on, positioning objects
is easy.

<> Left hold in the middle of the second rectangle. Move the
rectangle until it is lined up roughly as shown in the following
figure.
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..

. .
~

~

Positioning the rectangles

When you left click on an object away from any of the graphics
handles, you see an upright hand on top of the object. This hand
is your signal that when you move the cursor, you will move the
object. If you click on any of the graphics handles, you see a
pointing hand. If you move the cursor when you see the pointing
hand, you will stretch the object instead of moving it.

~

t

Left click
inside an object
to move it

~

t

Left click on a
handle to stretch
an object

Moving vs. stretching an object
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Now position the other third and fourth rectangles using the same
method.
~

Left hold inside each of the third and fourth rectangles. Drag
them into the positions shown in the following figure.

D
D
D

D
Aligning rectangles

Because you have grid mode turned on, the rectangles align easily
with each other.
The next step in making the map key is to fill in each rectangle
with the pattern of its corresponding region on the map. To fill in
objects, you select the object, then use the fill icons on the
graphics palette.

Filling in objects

~

Left click on the first rectangle to select it.
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<)

Left click on the fill pattern in the graphics palette that
matches the western-most region on the map.

Add:

[S][g]
[Q]E]
GJ~

E][Q]
[5]~
~[g]

~

Line:

I-I

El
1-1-1

(Take Down)

Selecting a fill pattern

The pattern appears in the selected rectangle.

D
D
D
Filled rectangle

Fill in the other three rectangles in the same way.
<)

Left click on the second rectangle to select it.

\> Left click on the fill pattern in the graphics palette as shown
in the following figure.
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Add:

[SJ[g]
Left click on

[QJ§J

this fill pattern

[3J~

EJ[QJ
DJ[DJ
~[S]

Ba

line: B
1-1-1-1-1
(Take Down)

Selecting a second fill pattern

This fill pattern appears in the second rectangle.

...........
k$~$~J~~

CJ

o
o
Filling the second rectangle

Fill the remaining two rectangles with the patterns shown in the
next figure.

<> Select each of the remaining rectangles in turn.
<l}

Fill each rectangle in turn.
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Use this fill
pattern for the
third rectangle

Add:

[SJ[g]
[Q]~

~G3

§][QJ
L5J~
~[S]

Ba

~~~tt-

.""

bld~[J]~[illJ

ml~rml

Pen: D
GJDDDDO[illill

Use this fill
pattern for the
fourth
rectangle

~ • • II.~~
[I]]~bld~[J]~[illJ

ml~rml
Line:

I-I

B

1-1-1

(Take Down)

Filling the third and fourth rectangles

When you are finished, the rectangles should look like the ones in
the figure below.

ITl
ITlIIIlIl

-

Filled rectangles

To finish the key, you add explanatory text beside the rectangles to
indicate the region each pattern refers to.

Adding text to a
graphic
<)

Left click on the text icon on the graphics palette.
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FiII:D

~DIIDD[]liilllll

~1II.1II11~~
m1~bld~DJ~fllil
mI~~
Pen:

It

~DgDD[]liilllll

~1II.1II1i1~~
m1~bld~DJ~fllil
1mJ~~
Line: EJ
1-1-1-1-1

(Take Down)

Selecting the text icon

The text icon dims to show that you can add text to the graphic.

o Position

the cursor beside the first rectangle and left click.

<> Enter the text as shown in the following figure.
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Western Regio').

EJ
ITIlIIIll

Entering text

Instead of pressing Return at the end of the line of text, you select
the text icon again and begin a separate block of text for the next
label. By creating each label separately, you can move and edit
them separately.
Create the next three labels by first selecting the text icon and then
entering the text.
~

Left click on the text icon on the graphics palette .

• Left click beside the second rectangle .
• Enter the following text:
Midwestern Region
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Continue to label the rectangles.

<> Left click on the text icon.
<> Left click beside the third rectangle.

<> Enter the following text:
Central Region
~~~!%!~

Western Region.

k<1

,\Y1idwestern Region

[]TI[llJ]

Central Regiolj..

.

Add the final label.
(.>

Left click on the text icon on the graphics palette.

\> Left click beside the last rectangle.

<> Enter the following text:
Eastern Seaboard Region

When you are finished, the graphic should look like the following
figure:
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Western Region.

D

Midwestern Region

[I]]]]]]

,jJentral Region.

~

Eastern Seaboard Regior:ll...

.

Key complete with labels
Adding a title to a
graphic

The sales regions map is almost complete. To finish it, you add a
title at the top, change the title to a larger point size, and make it
bold.
If you don't have enough room at the top of the graphic, drag one

of the corner handles up to make room.

o Left

click on the text icon on the graphics palette.
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Line: B
1-1-1-1-1

(Take Down)

Selecting the text icon

The icon dims to show that you can now add text to the graphic.
~

Move the pointer to the top of the graphic. Left click.

<> Enter the title as shown in the next figure.
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Enter the title here

Project Sa turn Sales

Region~

..

•

•
Western Region.

Adding a title

Notice that the title is in the same type as the text of the key
labels. Because you want the title to stand out, you change the
point size.
~ Right hold to bring up the Graphics menu.

Highlight the
Style option, and then highlight Font. Release.
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,project Saturn Sales Regions.

Western Region.

Changing the font

A dialog box listing the current type family, face, and size appears.
You want to change the style to 14 point Helvetica bold.
Font - - - - - - - - - . . . . ,
Family C helvetica
Face C Normal
Size
C 10 pt

((

OK

)]

(cancel)

Current font

~ Left click on the Face cycle button until you see the word

Bold appear.
~ Left click on the Size cycle button until you see 14 pt

appear.
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Font - - - - - - - - - - ,
Family C helvetica
Face
Id
Size

[

OK

)]

(Cancel)

Left click on these
cycle buttons

Selecting a new typeface and type size

<)

Left click on the OK button.
The title now appears in an 14 point bold font.

'project Saturn Sales Regions.

r$;$$$~7j

Western Region.

Title in 14 point bold font
Taking down the
graphics palette

Now that you are finished editing the graphic, take down the
graphics palette.
¢-

Left click on the Take Down button on the graphics palette.
The palette disappears.
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Saving

Now save your presentation.
~

Right hold on the File menu on the menu bar. Drag down
to highlight the Write option. Highlight the Same File
option. Release.
You are now ready to move on to the next chapter. To take a
break beforehand, exit from the software as described at the end of
Chapter 2.

What you've ;earned
This chapter taught you how to:

•

import an image from the file system

•

cut and paste a graphic from another BBN/Slate document

•

use the graphics tools by editing a graphic

You also learned the difference between an image and a graphic.
In the next chapter, you will print the document that you've
created during the last four chapters.
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7
BBN/Slate makes it easy for you to use very little paper in your
everyday work. You can send memos through electronic mail,
distribute company newsletters on-line, and review someone else's
documents through conferencing. However, you'll also want to
print out many of your documents.
With BBN/Slate, you can preview how your document will look
when printed, add page numbers and dates, specify headers and
footers for right and left pages, and much more.
Your presentation on Project Saturn is tomorrow. You want to
print out your document to hand out during the presentation.
During this work session, you:
•

make sure you are set up to print

•

add a footer to your document
preview your document

•
Before you begin

print your document

Before beginning this chapter, you should be in the document
Presentation, in the +New folder. If you exited BBN/Slate at
the end of the last chapter, re-enter the software first.

BBN/Slate prints to PostScript®-capable laser printers. Before you
begin working through this chapter, make sure that a PostScriptcapable printer is available from your workstation.
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Also make sure that your system administrator has set up your
printing commands correctly.

Adding a footer to your document
You decide to add a footer to your document which contains the
title, date, and page numbers. This information will help the
audience find what they are looking for during the presentation and
will help them file it away for future reference.
Adding a footer

When you add footers, you don't see them until you preview or
print out the document. To add a footer, you select the
Preview/Print option from the Print menu and fill in the
information in the dialog box.
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§}~~atl

Western Region

k>1

Midwestern Region

_

Central Region

_

Eastern Seaboard Region

Selecting the Preview/Print option from the Print menu

¢' Right hold on the Print menu on the menu bar. Highlight

the Preview/Print option. Release.
The Preview/Print dialog box appears.
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I

Page Dimensions
Width: 6.5i
Height: 11i

Margins - - - - - - - - - - - ,
left: .75i
Top:
.75i
Right: .75i
Bottom: .75i

orientation
@ Portrait
landscape

Page Numbers
'I Start page number:
1
Unnumbered title pages: 0

I
o
o Generate Table of Contents Ii Print Headers
o Odd-Even Page layout

I

Header
Both Pages:

I

Footer---------------------,
Both Pages: J..

Columns - - - - - - - - - . ,
Columns per page: 1
Gutter: .5i
Spooling - - - - - - - - - - - ,
@ To Printer 0 To Previewer
To File
0 Setup Only
Spooler: Ipr %s

Header/Footer Font
Family C helvetica
Face C Normal
Size
C 10 pt

o

[(

OK

)]

(cancel)

Preview/Print dialog box

BBN/Slate lets you put the same footer on all pages, or different
footers on odd and even pages. For different footers, you tell
BBN/Slate to use an odd-even page layout and then enter each
footer into the dialog box.
You decide to have the same footer on both pages.

o Left

click in the Footer field. Enter the following text:

Project Saturn-@date-@l
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The Footer field should look like this:
Enter the
footer
information
here
jage Dimensions Width: 8.5i
Height: iii

r

'/

1

I

Margins
Top:
.75i
Bottom: .75i

le:t: .75i
Rig : .75i

Page Numbers

oo ' . . . . -

@ Portrait

o landscape

I

~+:: 01

"'" Start
page number:
title pag
Unnumbered

o Generate Table of Contents
Elf Pri.,
o Odd-Even Page layout

1

Header
Both Pages:

i"'' '

I

1

Footer
I
Both Pages: Project saturn-@date-@{

1

Columns
Columns per page: 1
Gutter: .5i

Spooling
@ To Printer
To Previewer
To File
Setup Only
Spooler: Ipr %s

o

o
o

Header/Footer F o n t Family C helvetica
Face CNormal
Size
C 10 pt

((

OK

))

( cancel)

Creating a footer

You just added information for the page number, current date, as
well as the name of the document. When BBN/Slate prints the
document, it will print the current page number in place of the @1
and the current date in place of the @date. The tilde (-)
characters separate the footer into the left, center and right position
on the page.
When you are finished typing in the footers, you can use the same
dialog box to preview your document.
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Previewing your document
Previewing a document lets you see how it will look when printed.
Since what you see in the document editor is slightly different
from the printed output, you can preview it first to make sure it
will look as you expect.
Some elements of your document, such as headers and footers,
do not appear until you preview or print the document. In your
printed document, lines and pages may break differently, and
figures may may appear in a different position than on screen.
If you use the previewer first, you can make any necessary
adjustments before sending the document to the printer.
To preview a document, you select the Preview/Print option
from the menu bar, as you have already done. Or you can send it
directly to the previewer by using the Preview option from the
same menu.
Since you have already selected the Preview/Print option, you
are ready to send the document to the previewer.

Sending a
document to the
previewer
<)

Left click on the button beside the To Previewer option.

<> Left click on OK.
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Page Dimensions
Width: 8.5i
Height: iii

Margins - - - - - - - - - - - - - ,
Left: .75i
Top:
.75i
Right: .75i
Bottom: .75i

Orientation
@ Portrait
Landscape

Page Numbers - - - - - - - - - - ,
Start page number:
Unnumbered title pages: 0

o

o Generate Table of Contents
o Odd-Even Page Layout

E;i Print Headers

Header------------------------,
Both Pages:

I

Footer----------------------------~

Both Pages: Project Saturn-@date-@l,

Columns - - - - - - - - - - - - ,
Columns per page:
Gutter: .5i
Spooling - - - - - - - - - . . . . ,
To Printer • To Previewer
Setup Only
To File

Header/Footer Font
Family C helvetica
Face C Normal
Size
C 10 pt

o
o

[

OK

)]

(Cancel)

Left click here

Sending a document to the previewer

In a few seconds, the previewer window appears.
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'
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..

Saturn: Up and Coming in a Growing Market

The most. recent addition tD oW' product line. Project Setum is a soft\V81e package thet runs on
most. workstetions. Easy to leem end tD use, Project Setum is bound to become a be::tseller.
Unlike. many software packages, which ere limited to one or two machines, Pzoject Seturn is
available. on most workstations. What's more, the look end feel of Project Samm is the same
regerdless of the machine you use. Users on ell worksterions cen leem 'the softwere quickly and
produce proftssionel-qu6lity documents immwer:ely.

Proj3ctSatun

Fri May 11, 19i1J

Footer

Previewer window

Moving through
the document

There are several ways of paging through the document in the
previewer. You can use the scroll bars on the right side of the
window, the space bar, or the Previewer menu.
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~ Right hold anywhere within the previewer window to bring up
the previewer menu. Highlight the Next Page option.

Release.

Saturn: Up and Coming in a Growing Market

limited to one or two machines, Project Satum is

the look and feel of Project Saturn is the same
reg81dless of the machine you
produce prof essional-qualio/

on all workstations cen leem the softwere quickly end

immedie:tely.

Previewer menu

Using the previewer window

You now see the second page of your document.
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III1N/Slate,Page,Previewer. -

",,:

;

We expect high sales in E1JIope end in the United Ste:tes. Beceuse we have little compe~tion in
Europe, we aIlticipatt high s81.es during the first ytaI end incn,ases of 30% and 60% durmg the
second end third yeus, respectively.

The spree.d.shec:t end ~compenying bergraph below highlight the current sales projections for
SaOlrn:
.ALES PRaJECTIOI\6 (in millions 0($)
REGION
Region 1
GrQatBri'ain
1",lond
To,,"

R12gion2

a_gun
F"",,,,
Gema1Y
Wx2mbcLrg
N>~o1ands

Sw.ze1ond
To,,"

Rggion3
I,,"y

PcnJg>I
S •
To,,"

RQgion4
D;:nmark

'/'brv.ay
' and
Sv..ed91
To,,"

Tot:!JI1traJI

'ons

PropaSa1l.lTl

2

;

Second page of preview
Exiting the
previewer

Continue to page through the previewed document until you come
to the end. When you reach the last page, you are ready to exit
the previewer.

() Right hold to display the Previewer menu. Highlight Exit.
Release.
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Key Project Goals
Project Saturn will help us remain competitive in our current Europeen end Eastan United States
strongholds end move fOlW8l'd in 1he Western regions. 'Wi1h Project Sawn, we will also continue.
to lead our market segment end meintain our reputation for quality, innovative 9:lftware.

Exiting the previewer

After previewing your document, you are ready to send it to the
printer. You first set up your print options, and then send the
document to the printer.
Setting print
options

To set up your printing options, you use the PrevieW/Print
option and fill in the appropriate information.

<> Right hold on the Print menu on the menu bar. Highlight
the Preview/Print option. Release.
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Using the Preview/Print option to set print options

The Preview/Print dialog box appears.
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Page Dimensions
Width: 8.51
Height: iii

Margins - - - - - - - - - - - ,
Left: .75i
Top:
.75i
Right: .75i
Bottom: .75i

Orientation
@ Portrait
Landscape

Page Numbers - - - - - - - - - ,
Start page number:
Unnumbered title pages: 0
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o Generate Table of Contents
o Odd-Even Page Layout

~ Print Headers

I
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Both Pages:
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Both Pages: Project Saturn"'@date"'@i

Columns per page: 1
Gutter: .5i
Spooling - - - - - - - -....
@ To Printer 0 To Previewer
To File
0 Setup Only
Spooler": Ipr %s

Header/Footer Font
Family C helvetica
Face CNormal
Size
C 10 pt

o

[

OK

)]

(Cancel)

The Preview/Print dialog box

Notice that the footer information you entered earlier is still in
place.
Using this dialog box, you can set page dimensions, margins, and
orientation (whether the document prints vertically or horizontally).
You can also tell BBN/Slate whether to create a table of contents
for the document.
For now, you are only interested in printing the document with its
footers. You need to make sure that the spooling information is
set correctly. The spooling information contains the operatingsystem command you usually use to send files to the printer plus a
placeholder (% s) for the document name.
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In the figure below, the Spooler field contains the command
lpr %s. The word lpr is an operating-system command used to
send files to the printer, and %s is a placeholder for the name
Presentation. Your operating-system command may be
different.

,age Dimensions Width: 8.5i
Height: 11i

1

Margins
left: .75i
Right: .75i

Top:
.75i
Bottom: .75i

r"m,,"- l

Page Numbers
Start page number:
1
Unnumbered title pages: 0

@ Portrait

o landscape

o Generate Table of Contents
o Odd-Even Page layout

!;i Print Headers

I

Header
Both Pages:

I

Footer
., Both Pages: Project Saturn-@date-@1I..

I

Columns
Columns per page: 1
Gutter: .5i

Spooling
@ To Printer
To File
Spooler: it Ipr

o

7

o To Previewer
o Setup Only
%$

Header/Footer F o n t Family C helvetica
Face CNormal
Size
C 10 pt

~

OK

))

( Cancel )

/

Printing
command

Spooling information in the Preview/Print dialog box

<> Determine if the command listed in the Spooler field is
correct for your operating system.
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If you don't know whether this command is correct, contact your

system administrator.
• If the command listed is incorrect, left click at the end of the

command. Delete the command listed using the Delete key
and enter the correct command.
You are now ready to print.

• Left click on OK.
While BBN/Slate is creating the PostScript version of your
document, it remains on screen and you see an hourglass instead of
a cursor. When BBN/Slate finishes creating this version, you see
the cursor again.
If BBN/Slate has trouble printing your document, you will see a

message stating the reason. Contact your system administrator if
you cannot print from your workstation.

Exiting from BBN/Slate
You are finished working through this tutorial, so you can exit
from the document editor and from BBN/Slate. Before you exit,
save the Presentation document.
~

Right hold on the File menu. Highlight the Write option,
then highlight the Same File option. Release.
Your file is now saved.

Exiting from the
document editor

To exit from the document editor, use the Exit menu on the
menu bar.
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• Right hold on the Exit menu. Drag down to highlight the
Exi t option. Release.

i~~

Add

Edit

File

Mail

Print

DOGument

Editor

Project Saturn Sales Regions

Exiting from the document editor

Because you modified Presentation while setting it up for
printing, BBN/Slate asks you whether to save the modifications.
~ Left click on the Yes button.
Write out modified buffers before exiting?
((

Ves

)]

(

No

)

(CanGel)

The document editor now closes.
Exiting from
88N/Slate

Now exit from the software.
~ Left click on the done button in the document manager.
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( save
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/
Left click
here

Your window manager iconifies the document manager and places
it on your desktop. If you decide to re-enter BBN/Slate before
leaving your windowing system, left click on the icon to restart the
software.

What you've learned
In this chapter, you have:

•

added footers to your document

•

previewed your document

o

printed your document

•

exited from the document editor

•

exited from BBN/Slate

Now move on to the Epilogue to learn about becoming an
advanced BBN/Slate user.
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Epilogue
You have just put together a practice presentation with the help of
BBN/Slate software. You've seen first-hand how BBN/Slate makes
it easy for you to gather information from your colleagues in
remote places, to have other people review your ideas, and to
professionally present the finished product. While preparing this
presentation, you learned a lot about BBN/Slate's media types and
main features.

What you've learned
During the course of this tutorial, you have learned to work with
multimedia documents, create and edit most of the media types,
share information using electronic mail, and print documents.
Creating
multimedia
documents

You started with text, then gradually added other media types,
including an image, a graphic, spreadsheets, and business graphics.
You created the document in the document editor. Because the
document editor is integrated, you worked with all of the media
types without having to switch to other software programs.

Working with
media types

In this tutorial, you learned how to use most of the media types
available in BBN/Slate, including text, spreadsheets, business
graphs, images, and graphics. By working with each media type,
you learned how to use each of the media-type editors.

Epilogue 8-1

Sharing
information

To exchange information with other people, you learned how to
send multimedia documents through the mail and how to receive
mail from other users. You also learned how to print your
documents.

Managing your
work

While creating, mailing, and printing multimedia documents, you
learned to manage your work within BBN/Slate.
By working through the chapters in this tutorial, you also became
familiar with the document manager and the document editor, and
learned how to:

•

open folders and files

•

create folders

•

create new documents

•

move around in a document

•

close a document

•

open multiple files

•

copy files

•

exit from the document editor

•

exit from BBN/Slate

As you managed your work, you became comfortable using the
mouse to select options from menus, manage files and folders, and
respond to dialog boxes.

Moving on from here
You have accomplished a lot by going through this tutorial and
have learned enough to use BBN/Slate in your everyday work. As
you continue to use BBN/Slate, you'll discover other ways to make
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your work easier and faster. Not only will you become more
advanced in the topics you've seen a glimpse of here, but you will
also learn about other features, such as conferencing, enclosures,
and speech.
Becoming an
advanced user

While working with media types in this tutorial, you learned about
the basic operations for each one. As you work more with
BBN/Slate, you'll become acquainted with these more advanced
features:

Text. BBN/Slate comes with a variety of templates, which you
can use and adapt for yourself. Create your own templates for the
kinds of documents you create often, such as monthly reports and
letters. Other advanced text features include a spelling checker,
automatic section and figure numbering, and the Multilingual
Option, which allows you to write in different languages.
BBN/Slate makes frequent backup copies of your document
through a process called checkpointing. Every so often, BBN/Slate
saves your document to a UNIX file with the extension CKP. If
you should accidently leave BBN/Slate without saving your
document, you can use the CKP file as a backup. CKP files do
not appear in the document summary pane. Be aware that CKP
files may not contain your most recent changes. To be sure you
don't lose any information, frequently save the document yourself.

Spreadsheets. Using the spreadsheet editor, you can sort entire
spreadsheets or regions of spreadsheets by one value or several.
You can generate line graphs as well as bargraphs and piecharts,
and you can read in data from or write data to Lotusl-2-3™
spreadsheets.
Graphics and images. In addition to the features you worked
with, you can add arrows to any graphics and edit any objects to
change the line thickness, line pattern, or fill patterns. As well as
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importing black-and-white images, you can import color images
from your file system or capture images from your workstation
display. You can scale, invert, and reflect entire images or any
part of them.

Electronic mail. Because electronic mail is easy to use in
BBN/Slate, you may soon find yourself using mail for multiple
tasks. For example, if you have a company or department
newsletter, put it in BBN/Slate and distribute it electronically.
You'll save yourself time and paper.
You might benefit unexpectedly from using multimedia mail.
Because you can communicate complex ideas quickly, you will be
able to make well-informed decisions faster.

Document management. In the document manager, you can sort
files, delete files, delete or rename folders, move files from one
folder to another, and even link folders to particular directories in
your file system. BBN/Slate also lets you set folder permissions
so that only certain users or groups may read or write to specified
folders.
Learning other
features

Experiment with other features that you didn't tryout in this
tutorial.

Speech. If you have the appropriate workstation configuration,
you can insert and play back digitized voice annotations. Use the
speech feature to make comments on documents you are reviewing
for other people, to personalize mail messages, or to add interest to
on-line newsletters.
Conferencing. BBN/Slate includes a feature that lets you confer
over documents with other users. Several people can confer at the
same time, although only one person can take control of the
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document at once. If you own the document, you can decide
whether or not to save the changes made during the conference. A
similar feature is the conversation window, which lets you confer
by typing a dialog with other BBN/Slate users.
Enclosures. What if you need to send an external file to a
BBN/Slate user? Using a multimedia document as an envelope,
you can send data from UNIX files, the executable file itself, or a
reference to the file to anyone using BBN/Slate. By including an
executable file as an enclosure, you can turn BBN/Slate into a
control panel to control other programs.
Extension language. BBN/Slate contains its own programming
language that lets you customize your own environment or that of
your work group. You can use the Slate Extension Language
(SEL) to automate many of the routine tasks that you do every
day.
If you want to go through the tutorial again, first delete the +New
folder and all the documents in it. First, make sure you are in
BBN/Slate.

Repeating the
tutorial

¢' Using the left mouse button, double-click on the name +New in

the folder list.
~

Right hold on the folder button.

() Highlight the Delete Folder option.

0> Release.
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BBN

Welcome to BBN/Sla te Release 1.1

C§Q
(forward)

~
~
~
~~~~

Deleting a folder

Because this folder contains files, BBN/Slate asks whether to delete
the folder and all the files in it.

~:
,.

The folder- is not empty.
Delete it anyway?

..

((

OK

)) (

No

)

Deleting a folder containing documents

Answer yes.
~

Left click on the OK button.
You can now repeat the tutorial.

Finding out more
information

To learn more about BBN/Slate, see the Reference Manual, the
Customizing Manual, the System Topics manual, and if you have
the Multilingual Option, the Multilingual Documents manual. The
more you work with BBN/Slate, the more you'll discover new
ways to make BBN/Slate work for you.
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